Objectives

After completing this chapter, you should be able to

1. Summarize data, using measures of central tendency, such as the mean, median, mode, and midrange.
2. Describe data, using measures of variation, such as the range, variance, and standard deviation.
3. Identify the position of a data value in a data set, using various measures of position, such as percentiles, deciles, and quartiles.
4. Use the techniques of exploratory data analysis, including boxplots and five-number summaries, to discover various aspects of data.

Outline

Introduction

3–1 Measures of Central Tendency
3–2 Measures of Variation
3–3 Measures of Position
3–4 Exploratory Data Analysis
Summary
How Long Are You Delayed by Road Congestion?

No matter where you live, at one time or another, you have been stuck in traffic. To see whether there are more traffic delays in some cities than in others, statisticians make comparisons using descriptive statistics. A statistical study by the Texas Transportation Institute found that a driver is delayed by road congestion an average of 36 hours per year. To see how selected cities compare to this average, see Statistics Today—Revisited at the end of the chapter.

This chapter will show you how to obtain and interpret descriptive statistics such as measures of average, measures of variation, and measures of position.

Introduction

Chapter 2 showed how you can gain useful information from raw data by organizing them into a frequency distribution and then presenting the data by using various graphs. This chapter shows the statistical methods that can be used to summarize data. The most familiar of these methods is the finding of averages.

For example, you may read that the average speed of a car crossing midtown Manhattan during the day is 5.3 miles per hour or that the average number of minutes an American father of a 4-year-old spends alone with his child each day is 42.1

In the book *American Averages* by Mike Feinsilber and William B. Meed, the authors state:

“Average” when you stop to think of it is a funny concept. Although it describes all of us it describes none of us . . . While none of us wants to be the average American, we all want to know about him or her.

The authors go on to give examples of averages:

*The average American man is five feet, nine inches tall; the average woman is five feet, 3.6 inches.*

*The average American is sick in bed seven days a year missing five days of work.*

*On the average day, 24 million people receive animal bites.*

*By his or her 70th birthday, the average American will have eaten 14 steers, 1050 chickens, 3.5 lambs, and 25.2 hogs.*


In these examples, the word *average* is ambiguous, since several different methods can be used to obtain an average. Loosely stated, the average means the center of the distribution or the most typical case. Measures of average are also called *measures of central tendency* and include the *mean*, *median*, *mode*, and *midrange*.

Knowing the average of a data set is not enough to describe the data set entirely. Even though a shoe store owner knows that the average size of a man’s shoe is size 10, she would not be in business very long if she ordered only size 10 shoes.

As this example shows, in addition to knowing the average, you must know how the data values are dispersed. That is, do the data values cluster around the mean, or are they spread more evenly throughout the distribution? The measures that determine the spread of the data values are called *measures of variation*, or *measures of dispersion*. These measures include the *range*, *variance*, and *standard deviation*.

Finally, another set of measures is necessary to describe data. These measures are called *measures of position*. They tell where a specific data value falls within the data set or its relative position in comparison with other data values. The most common position measures are *percentiles*, *deciles*, and *quartiles*. These measures are used extensively in psychology and education. Sometimes they are referred to as *norms*.

The measures of central tendency, variation, and position explained in this chapter are part of what is called *traditional statistics*.

Section 3–4 shows the techniques of what is called *exploratory data analysis*. These techniques include the *boxplot* and the *five-number summary*. They can be used to explore data to see what they show (as opposed to the traditional techniques, which are used to confirm conjectures about the data).

### Measures of Central Tendency

Chapter 1 stated that statisticians use samples taken from populations; however, when populations are small, it is not necessary to use samples since the entire population can be used to gain information. For example, suppose an insurance manager wanted to know the average weekly sales of all the company’s representatives. If the company employed a large number of salespeople, say, nationwide, he would have to use a sample and make
an inference to the entire sales force. But if the company had only a few salespeople, say, only 87 agents, he would be able to use all representatives’ sales for a randomly chosen week and thus use the entire population.

Measures found by using all the data values in the population are called parameters. Measures obtained by using the data values from samples are called statistics; hence, the average of the sales from a sample of representatives is a statistic, and the average of sales obtained from the entire population is a parameter.

A statistic is a characteristic or measure obtained by using the data values from a sample. A parameter is a characteristic or measure obtained by using all the data values from a specific population.

These concepts as well as the symbols used to represent them will be explained in detail in this chapter.

**General Rounding Rule** In statistics the basic rounding rule is that when computations are done in the calculation, rounding should not be done until the final answer is calculated. When rounding is done in the intermediate steps, it tends to increase the difference between that answer and the exact one. But in the textbook and solutions manual, it is not practical to show long decimals in the intermediate calculations; hence, the values in the examples are carried out to enough places (usually three or four) to obtain the same answer that a calculator would give after rounding on the last step.

**The Mean**

The mean, also known as the arithmetic average, is found by adding the values of the data and dividing by the total number of values. For example, the mean of 3, 2, 6, 5, and 4 is found by adding $3 + 2 + 6 + 5 + 4 = 20$ and dividing by 5; hence, the mean of the data is $20 / 5 = 4$. The values of the data are represented by $X$’s. In this data set, $X_1 = 3$, $X_2 = 2$, $X_3 = 6$, $X_4 = 5$, and $X_5 = 4$. To show a sum of the total $X$ values, the symbol $\Sigma$ (the capital Greek letter sigma) is used, and $\Sigma X$ means to find the sum of the $X$ values in the data set. The summation notation is explained in Appendix A.

The mean is the sum of the values, divided by the total number of values. The symbol $\bar{X}$ represents the sample mean.

$$\bar{X} = \frac{X_1 + X_2 + X_3 + \cdots + X_n}{n} = \frac{\Sigma X}{n}$$

where $n$ represents the total number of values in the sample.

For a population, the Greek letter $\mu$ (mu) is used for the mean.

$$\mu = \frac{X_1 + X_2 + X_3 + \cdots + X_N}{N} = \frac{\Sigma X}{N}$$

where $N$ represents the total number of values in the population.

In statistics, Greek letters are used to denote parameters, and Roman letters are used to denote statistics. Assume that the data are obtained from samples unless otherwise specified.

**Example 3–1**

**Days Off per Year**

The data represent the number of days off per year for a sample of individuals selected from nine different countries. Find the mean.

20, 26, 40, 36, 23, 42, 35, 24, 30

Source: World Tourism Organization.
Example 3–2

Area Boat Registrations

The data shown represent the number of boat registrations for six counties in southwestern Pennsylvania. Find the mean.

\[ \text{3782, 6367, 9002, 4208, 6843, 11,008} \]

Source: Pennsylvania Fish and Boat Commission.

Solution

\[ \bar{X} = \frac{\sum X}{n} = \frac{3782 + 6367 + 9002 + 4208 + 6843 + 11,008}{6} = 6868.3 \]

The mean for the six county boat registrations is 6868.3.

The mean, in most cases, is not an actual data value.

Rounding Rule for the Mean  The mean should be rounded to one more decimal place than occurs in the raw data. For example, if the raw data are given in whole numbers, the mean should be rounded to the nearest tenth. If the data are given in tenths, the mean should be rounded to the nearest hundredth, and so on.

The procedure for finding the mean for grouped data uses the midpoints of the classes. This procedure is shown next.

Example 3–3

Miles Run per Week

Using the frequency distribution for Example 2–7, find the mean. The data represent the number of miles run during one week for a sample of 20 runners.

Solution

The procedure for finding the mean for grouped data is given here.

Step 1  Make a table as shown.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Frequency</td>
<td>Midpoint $X_m$</td>
<td>$f \cdot X_m$</td>
</tr>
<tr>
<td>5.5–10.5</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.5–15.5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15.5–20.5</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20.5–25.5</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25.5–30.5</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30.5–35.5</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35.5–40.5</td>
<td>2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\[ n = 20 \]

Step 2  Find the midpoints of each class and enter them in column C.

\[ X_m = \frac{5.5 + 10.5}{2} = 8 \quad \frac{10.5 + 15.5}{2} = 13 \quad \text{etc.} \]
For each class, multiply the frequency by the midpoint, as shown, and place the product in column D.

\[1 \cdot 8 = 8 \quad 2 \cdot 13 = 26 \quad \text{etc.}\]

The completed table is shown here.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Frequency</td>
<td>Midpoint</td>
<td>(X_m f)</td>
</tr>
<tr>
<td>5.5–10.5</td>
<td>1</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>10.5–15.5</td>
<td>2</td>
<td>13</td>
<td>26</td>
</tr>
<tr>
<td>15.5–20.5</td>
<td>3</td>
<td>18</td>
<td>54</td>
</tr>
<tr>
<td>20.5–25.5</td>
<td>5</td>
<td>23</td>
<td>115</td>
</tr>
<tr>
<td>25.5–30.5</td>
<td>4</td>
<td>28</td>
<td>112</td>
</tr>
<tr>
<td>30.5–35.5</td>
<td>3</td>
<td>33</td>
<td>99</td>
</tr>
<tr>
<td>35.5–40.5</td>
<td>2</td>
<td>38</td>
<td>76</td>
</tr>
</tbody>
</table>

\[n = 20 \quad \Sigma f \cdot X_m = 490\]

**Step 4** Find the sum of column D.

**Step 5** Divide the sum by \(n\) to get the mean.

\[
\bar{X} = \frac{\Sigma f \cdot X_m}{n} = \frac{490}{20} = 24.5 \text{ miles}
\]

The procedure for finding the mean for grouped data assumes that the mean of all the raw data values in each class is equal to the midpoint of the class. In reality, this is not true, since the average of the raw data values in each class usually will not be exactly equal to the midpoint. However, using this procedure will give an acceptable approximation of the mean, since some values fall above the midpoint and other values fall below the midpoint for each class, and the midpoint represents an estimate of all values in the class.

The steps for finding the mean for grouped data are summarized in the next Procedure Table.

### Procedure Table

**Finding the Mean for Grouped Data**

**Step 1** Make a table as shown.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Frequency</td>
<td>Midpoint</td>
<td>(f \cdot X_m)</td>
</tr>
</tbody>
</table>

**Step 2** Find the midpoints of each class and place them in column C.

**Step 3** Multiply the frequency by the midpoint for each class, and place the product in column D.

**Step 4** Find the sum of column D.

**Step 5** Divide the sum obtained in column D by the sum of the frequencies obtained in column B.

The formula for the mean is

\[
\bar{X} = \frac{\Sigma f \cdot X_m}{n}
\]

[Note: The symbols \(\Sigma f \cdot X_m\) mean to find the sum of the product of the frequency \((f)\) and the midpoint \((X_m)\) for each class.]
Ages of the Top 50 Wealthiest People
The histogram shows the ages of the top 50 wealthiest individuals according to Forbes Magazine for a recent year. The mean age is 66.04 years. The median age is 68 years. Explain why these two statistics are not enough to adequately describe the data.

The Median
An article recently reported that the median income for college professors was $43,250. This measure of central tendency means that one-half of all the professors surveyed earned more than $43,250, and one-half earned less than $43,250.

The median is the halfway point in a data set. Before you can find this point, the data must be arranged in order. When the data set is ordered, it is called a data array. The median either will be a specific value in the data set or will fall between two values, as shown in Examples 3–4 through 3–8.

Steps in computing the median of a data array

**Step 1** Arrange the data in order.

**Step 2** Select the middle point.
Chapter 3 Data Description

Example 3–4 Hotel Rooms

The number of rooms in the seven hotels in downtown Pittsburgh is 713, 300, 618, 595, 311, 401, and 292. Find the median.

Source: Interstate Hotels Corporation.

Solution

Step 1 Arrange the data in order.

292, 300, 311, 401, 595, 618, 713

Step 2 Select the middle value.

292, 300, 311, 401, 595, 618, 713

Median

Hence, the median is 401 rooms.

Example 3–5 National Park Vehicle Pass Costs

Find the median for the daily vehicle pass charge for five U.S. National Parks. The costs are $25, $15, $15, $20, and $15.

Source: National Park Service.

Solution

$15 $15 $15 $20 $25

Median

The median cost is $15.

Examples 3–4 and 3–5 each had an odd number of values in the data set; hence, the median was an actual data value. When there are an even number of values in the data set, the median will fall between two given values, as illustrated in Examples 3–6, 3–7, and 3–8.

Example 3–6 Tornadoes in the United States

The number of tornadoes that have occurred in the United States over an 8-year period follows. Find the median.

684, 764, 656, 702, 856, 1133, 1132, 1303

Source: The Universal Almanac.

Solution

656, 684, 702, 764, 856, 1132, 1133, 1303

Median

Since the middle point falls halfway between 764 and 856, find the median MD by adding the two values and dividing by 2.

\[ MD = \frac{764 + 856}{2} = \frac{1620}{2} = 810 \]

The median number of tornadoes is 810.
### Example 3–7  
**Cloudy Days**

The number of cloudy days for the top 10 cloudiest cities is shown. Find the median.

209, 223, 211, 227, 213, 240, 240, 211, 229, 212

*Source: National Climatic Data Center.*

**Solution**

Arrange the data in order.

209, 211, 211, 212, 213, 223, 227, 229, 240, 240

\[
\text{Median} = \frac{213 + 223}{2} = 218
\]

Hence, the median is 218 days.

### Example 3–8  
**Magazines Purchased**

Six customers purchased these numbers of magazines: 1, 7, 3, 2, 3, 4. Find the median.

**Solution**

\[
\text{Median} = \frac{3 + 3}{2} = 3
\]

Hence, the median number of magazines purchased is 3.

### The Mode

The third measure of average is called the *mode*. The mode is the value that occurs most often in the data set. It is sometimes said to be the most typical case.

The value that occurs most often in a data set is called the **mode**.

A data set that has only one value that occurs with the greatest frequency is said to be **unimodal**.

If a data set has two values that occur with the same greatest frequency, both values are considered to be the mode and the data set is said to be **bimodal**. If a data set has more than two values that occur with the same greatest frequency, each value is used as the mode, and the data set is said to be **multimodal**. When no data value occurs more than once, the data set is said to have **no mode**. A data set can have more than one mode or no mode at all. These situations will be shown in some of the examples that follow.

### Example 3–9  
**NFL Signing Bonuses**

Find the mode of the signing bonuses of eight NFL players for a specific year. The bonuses in millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10

*Source: USA TODAY.*
Chapter 3 Data Description

Example 3–10 Coal Employees in Pennsylvania

Find the mode for the number of coal employees per county for 10 selected counties in southwestern Pennsylvania.

110, 731, 1031, 84, 20, 118, 1162, 1977, 103, 752

Source: Pittsburgh Tribune-Review.

Solution

Since each value occurs only once, there is no mode.

Note: Do not say that the mode is zero. That would be incorrect, because in some data, such as temperature, zero can be an actual value.

Example 3–11 Licensed Nuclear Reactors

The data show the number of licensed nuclear reactors in the United States for a recent 15-year period. Find the mode.


104 104 104 104 104
107 109 109 109 110
109 111 112 111 109

Solution

Since the values 104 and 109 both occur 5 times, the modes are 104 and 109. The data set is said to be bimodal.

The mode for grouped data is the modal class. The modal class is the class with the largest frequency.

Example 3–12 Miles Run per Week

Find the modal class for the frequency distribution of miles that 20 runners ran in one week, used in Example 2–7.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5–10.5</td>
<td>1</td>
</tr>
<tr>
<td>10.5–15.5</td>
<td>2</td>
</tr>
<tr>
<td>15.5–20.5</td>
<td>3</td>
</tr>
<tr>
<td>20.5–25.5</td>
<td>5 ← Modal class</td>
</tr>
<tr>
<td>25.5–30.5</td>
<td>4</td>
</tr>
<tr>
<td>30.5–35.5</td>
<td>3</td>
</tr>
<tr>
<td>35.5–40.5</td>
<td>2</td>
</tr>
</tbody>
</table>
The mode is the only measure of central tendency that can be used in finding the most typical case when the data are nominal or categorical.
Chapter 3 Data Description

In Example 3–14, the mean is much higher than the median or the mode. This is so because the extremely high salary of the owner tends to raise the value of the mean. In this and similar situations, the median should be used as the measure of central tendency.

The Midrange

The midrange is a rough estimate of the middle. It is found by adding the lowest and highest values in the data set and dividing by 2. It is a very rough estimate of the average and can be affected by one extremely high or low value.

\[
\text{The midrange is defined as the sum of the lowest and highest values in the data set, divided by 2. The symbol } MR \text{ is used for the midrange.}
\]

\[
MR = \frac{\text{lowest value} + \text{highest value}}{2}
\]

Example 3–15 Water-Line Breaks

In the last two winter seasons, the city of Brownsville, Minnesota, reported these numbers of water-line breaks per month. Find the midrange.

2, 3, 6, 8, 4, 1

Solution

\[
MR = \frac{1 + 8}{2} = \frac{9}{2} = 4.5
\]

Hence, the midrange is 4.5.

If the data set contains one extremely large value or one extremely small value, a higher or lower midrange value will result and may not be a typical description of the middle.

Example 3–16 NFL Signing Bonuses

Find the midrange of data for the NFL signing bonuses in Example 3–9. The bonuses in millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10

Solution

The smallest bonus is $10 million and the largest bonus is $34.5 million.

\[
MR = \frac{10 + 34.5}{2} = \frac{44.5}{2} = \$22.25 \text{ million}
\]

Notice that this amount is larger than seven of the eight amounts and is not typical of the average of the bonuses. The reason is that there is one very high bonus, namely, $34.5 million.
In statistics, several measures can be used for an average. The most common measures are the mean, median, mode, and midrange. Each has its own specific purpose and use. Exercises 39 through 41 show examples of other averages, such as the harmonic mean, the geometric mean, and the quadratic mean. Their applications are limited to specific areas, as shown in the exercises.

**The Weighted Mean**

Sometimes, you must find the mean of a data set in which not all values are equally represented. Consider the case of finding the average cost of a gallon of gasoline for three taxis. Suppose the drivers buy gasoline at three different service stations at a cost of $3.22, $3.53, and $3.63 per gallon. You might try to find the average by using the formula

\[ \bar{X} = \frac{\sum X}{n} \]

But not all drivers purchased the same number of gallons. Hence, to find the true average cost per gallon, you must take into consideration the number of gallons each driver purchased.

The type of mean that considers an additional factor is called the **weighted mean**, and it is used when the values are not all equally represented.

Find the **weighted mean** of a variable \( X \) by multiplying each value by its corresponding weight and dividing the sum of the products by the sum of the weights.

\[ \bar{X} = \frac{\sum wX}{\sum w} \]

where \( w_1, w_2, \ldots, w_n \) are the weights and \( X_1, X_2, \ldots, X_n \) are the values.

Example 3–17 shows how the weighted mean is used to compute a grade point average. Since courses vary in their credit value, the number of credits must be used as weights.

**Example 3–17**

**Grade Point Average**

A student received an A in English Composition I (3 credits), a C in Introduction to Psychology (3 credits), a B in Biology I (4 credits), and a D in Physical Education (2 credits). Assuming A = 4 grade points, B = 3 grade points, C = 2 grade points, D = 1 grade point, and F = 0 grade points, find the student’s grade point average.

**Solution**

<table>
<thead>
<tr>
<th>Course</th>
<th>Credits (( w ))</th>
<th>Grade (( X ))</th>
</tr>
</thead>
<tbody>
<tr>
<td>English Composition I</td>
<td>3</td>
<td>A (4 points)</td>
</tr>
<tr>
<td>Introduction to Psychology</td>
<td>3</td>
<td>C (2 points)</td>
</tr>
<tr>
<td>Biology I</td>
<td>4</td>
<td>B (3 points)</td>
</tr>
<tr>
<td>Physical Education</td>
<td>2</td>
<td>D (1 point)</td>
</tr>
</tbody>
</table>

\[ \bar{X} = \frac{\sum wX}{\sum w} = \frac{3 \cdot 4 + 3 \cdot 2 + 4 \cdot 3 + 2 \cdot 1}{3 + 3 + 4 + 2} = \frac{32}{12} = 2.7 \]

The grade point average is 2.7.
Table 3–1 summarizes the measures of central tendency.

### Table 3–1 Summary of Measures of Central Tendency

<table>
<thead>
<tr>
<th>Measure</th>
<th>Definition</th>
<th>Symbol(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>Sum of values, divided by total number of values</td>
<td>$\mu, \bar{X}$</td>
</tr>
<tr>
<td>Median</td>
<td>Middle point in data set that has been ordered</td>
<td>MD</td>
</tr>
<tr>
<td>Mode</td>
<td>Most frequent data value</td>
<td>None</td>
</tr>
<tr>
<td>Midrange</td>
<td>Lowest value plus highest value, divided by 2</td>
<td>MR</td>
</tr>
</tbody>
</table>

Researchers and statisticians must know which measure of central tendency is being used and when to use each measure of central tendency. The properties and uses of the four measures of central tendency are summarized next.

### Properties and Uses of Central Tendency

**The Mean**
1. The mean is found by using all the values of the data.
2. The mean varies less than the median or mode when samples are taken from the same population and all three measures are computed for these samples.
3. The mean is used in computing other statistics, such as the variance.
4. The mean for the data set is unique and not necessarily one of the data values.
5. The mean cannot be computed for the data in a frequency distribution that has an open-ended class.
6. The mean is affected by extremely high or low values, called outliers, and may not be the appropriate average to use in these situations.

**The Median**
1. The median is used to find the center or middle value of a data set.
2. The median is used when it is necessary to find out whether the data values fall into the upper half or lower half of the distribution.
3. The median is used for an open-ended distribution.
4. The median is affected less than the mean by extremely high or extremely low values.

**The Mode**
1. The mode is used when the most typical case is desired.
2. The mode is the easiest average to compute.
3. The mode can be used when the data are nominal, such as religious preference, gender, or political affiliation.
4. The mode is not always unique. A data set can have more than one mode, or the mode may not exist for a data set.

**The Midrange**
1. The midrange is easy to compute.
2. The midrange gives the midpoint.
3. The midrange is affected by extremely high or low values in a data set.
Distribution Shapes

Frequency distributions can assume many shapes. The three most important shapes are positively skewed, symmetric, and negatively skewed. Figure 3–1 shows histograms of each.

In a positively skewed or right-skewed distribution, the majority of the data values fall to the left of the mean and cluster at the lower end of the distribution; the “tail” is to the right. Also, the mean is to the right of the median, and the mode is to the left of the median.

For example, if an instructor gave an examination and most of the students did poorly, their scores would tend to cluster on the left side of the distribution. A few high scores would constitute the tail of the distribution, which would be on the right side. Another example of a positively skewed distribution is the incomes of the population of the United States. Most of the incomes cluster about the low end of the distribution; those with high incomes are in the minority and are in the tail at the right of the distribution.

In a symmetric distribution, the data values are evenly distributed on both sides of the mean. In addition, when the distribution is unimodal, the mean, median, and mode are the same and are at the center of the distribution. Examples of symmetric distributions are IQ scores and heights of adult males.

When the majority of the data values fall to the right of the mean and cluster at the upper end of the distribution, with the tail to the left, the distribution is said to be negatively skewed or left-skewed. Also, the mean is to the left of the median, and the mode is to the right of the median. As an example, a negatively skewed distribution results if the majority of students score very high on an instructor’s examination. These scores will tend to cluster to the right of the distribution.

When a distribution is extremely skewed, the value of the mean will be pulled toward the tail, but the majority of the data values will be greater than the mean or less than the mean (depending on which way the data are skewed); hence, the median rather than the mean is a more appropriate measure of central tendency. An extremely skewed distribution can also affect other statistics.

A measure of skewness for a distribution is discussed in Exercise 48 in Section 3–2.
Applying the Concepts 3–1

Teacher Salaries
The following data represent salaries (in dollars) from a school district in Greenwood, South Carolina.

<table>
<thead>
<tr>
<th>Salary</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10,000</td>
<td>11,000</td>
</tr>
<tr>
<td>11,000</td>
<td>12,500</td>
</tr>
<tr>
<td>14,300</td>
<td>18,000</td>
</tr>
<tr>
<td>19,200</td>
<td>21,560</td>
</tr>
<tr>
<td>16,400</td>
<td>16,400</td>
</tr>
<tr>
<td>107,000</td>
<td></td>
</tr>
</tbody>
</table>

1. First, assume you work for the school board in Greenwood and do not wish to raise taxes to increase salaries. Compute the mean, median, and mode, and decide which one would best support your position to not raise salaries.

2. Second, assume you work for the teachers’ union and want a raise for the teachers. Use the best measure of central tendency to support your position.

3. Explain how outliers can be used to support one or the other position.

4. If the salaries represented every teacher in the school district, would the averages be parameters or statistics?

5. Which measure of central tendency can be misleading when a data set contains outliers?

6. When you are comparing the measures of central tendency, does the distribution display any skewness? Explain.

See page 180 for the answers.

Exercises 3–1

For Exercises 1 through 8, find (a) the mean, (b) the median, (c) the mode, and (d) the midrange.

1. Grade Point Averages The average undergraduate grade point average (GPA) for the 25 top-ranked medical schools is listed below.

<table>
<thead>
<tr>
<th>GPA</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.80</td>
</tr>
<tr>
<td>3.86</td>
</tr>
<tr>
<td>3.83</td>
</tr>
<tr>
<td>3.78</td>
</tr>
</tbody>
</table>


2. Heights of the Highest Waterfalls The heights (in feet) of the 20 highest waterfalls in the world are shown here. (Note: The height of Niagara Falls is 182 feet!)

<table>
<thead>
<tr>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>3212</td>
</tr>
<tr>
<td>2800</td>
</tr>
<tr>
<td>2540</td>
</tr>
</tbody>
</table>


3. High Temperatures The reported high temperatures (in degrees Fahrenheit) for selected world cities on an October day are shown below. Which measure of central tendency do you think best describes these data?

<table>
<thead>
<tr>
<th>Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>62</td>
</tr>
<tr>
<td>72</td>
</tr>
<tr>
<td>66</td>
</tr>
<tr>
<td>79</td>
</tr>
</tbody>
</table>

Source: www.accuweather.com

4. Observers in the Frogwatch Program The number of observers in the Frogwatch USA program (a wildlife conservation program dedicated to helping conserve frogs and toads) for the top 10 states with the most observers is 484, 483, 422, 396, 378, 352, 338, 331, 318, and 302. The top 10 states with the most active watchers list these numbers of visits: 634, 464, 406, 267, 219, 194, 191, 150, 130, and 114. Compare the measures of central tendency for these two groups of data.

Source: www.nwf.org/frogwatch

5. Expenditures per Pupil for Selected States The expenditures per pupil for selected states are listed below. Based on these data, what do you think of the claim that the average expenditure per pupil in the United States exceeds $10,000?

<table>
<thead>
<tr>
<th>Expenditure</th>
</tr>
</thead>
<tbody>
<tr>
<td>6,300</td>
</tr>
<tr>
<td>10,460</td>
</tr>
<tr>
<td>7,552</td>
</tr>
</tbody>
</table>


6. Earnings of Nonliving Celebrities Forbes magazine prints an annual Top-Earning Nonliving Celebrities list (based on royalties and estate earnings). Find the measures of central tendency for these data and comment on the skewness. Figures represent millions of dollars.
Kurt Cobain 50 Ray Charles 10
Elvis Presley 42 Marilyn Monroe 8
Charles M. Schulz 35 Johnny Cash 8
John Lennon 24 J.R.R. Tolkien 7
Albert Einstein 20 George Harrison 7
Andy Warhol 19 Bob Marley 7
Theodore Geisel 10 (Dr. Seuss)

Source: articles.moneycentral.msn.com

7. Earthquake Strengths Twelve major earthquakes had Richter magnitudes shown here.
7.0, 6.2, 7.7, 8.0, 6.4, 6.2, 7.2, 5.4, 6.4, 6.5, 7.2, 5.4

Which would you consider the best measure of average?
Source: The Universal Almanac.

8. Top-Paid CEOs The data shown are the total compensation (in millions of dollars) for the 50 top-paid CEOs for a recent year. Compare the averages, and state which one you think is the best measure.
17.5 18.0 36.8 31.7 31.7
17.3 24.3 47.7 38.5 17.0
23.7 16.5 25.1 17.4 18.0
37.6 19.7 21.4 28.6 21.6
19.3 20.0 16.9 25.2 19.8
25.0 17.2 20.4 20.1 29.1
19.1 25.2 23.2 25.9 24.0
41.7 24.0 16.8 26.8 31.4
16.9 17.2 24.1 35.2 19.1
22.9 18.2 25.4 35.4 25.5

Source: USA TODAY.

9. Find the (a) mean, (b) median, (c) mode, and (d) midrange for the data in Exercise 17 in Section 2–1. Is the distribution symmetric or skewed? Use the individual data values.

10. Find the (a) mean, (b) median, (c) mode, and (d) midrange for the distances of the home runs for McGwire and Sosa, using the data in Exercise 18 in Section 2–1.

Compare the means. Decide if the means are approximately equal or if one of the players is hitting longer home runs. Use the individual data values.

11. Populations of Selected Cities Populations for towns and cities of 5000 or more (based on the 2004 figures) in the 15XXX zip code area are listed here for two different years. Find the mean, median, mode, and midrange for each set of data. What do your findings suggest?

<table>
<thead>
<tr>
<th>2004</th>
<th>1990</th>
</tr>
</thead>
<tbody>
<tr>
<td>11,270</td>
<td>13,374</td>
</tr>
<tr>
<td>8,220</td>
<td>9,278</td>
</tr>
<tr>
<td>5,463</td>
<td>6,113</td>
</tr>
<tr>
<td>8,739</td>
<td>9,229</td>
</tr>
<tr>
<td>6,199</td>
<td>10,687</td>
</tr>
<tr>
<td>10,309</td>
<td>11,221</td>
</tr>
<tr>
<td>9,964</td>
<td>10,823</td>
</tr>
<tr>
<td>14,340</td>
<td>14,292</td>
</tr>
</tbody>
</table>


For Exercises 12 through 21, find the (a) mean and (b) modal class.

12. Exam Scores For 108 randomly selected college students, this exam score frequency distribution was obtained. (The data in this exercise will be used in Exercise 18 in Section 3–2.)

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>90–98</td>
<td>6</td>
</tr>
<tr>
<td>99–107</td>
<td>22</td>
</tr>
<tr>
<td>108–116</td>
<td>43</td>
</tr>
<tr>
<td>117–125</td>
<td>28</td>
</tr>
<tr>
<td>126–134</td>
<td>9</td>
</tr>
</tbody>
</table>

13. Hourly Compensation for Production Workers The hourly compensation costs (in U.S. dollars) for production workers in selected countries are represented below. Find the mean and modal class.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.48–7.48</td>
<td>7</td>
</tr>
<tr>
<td>7.49–12.49</td>
<td>3</td>
</tr>
<tr>
<td>12.50–17.50</td>
<td>1</td>
</tr>
<tr>
<td>17.51–22.51</td>
<td>7</td>
</tr>
<tr>
<td>22.52–27.52</td>
<td>5</td>
</tr>
<tr>
<td>27.53–32.53</td>
<td>5</td>
</tr>
</tbody>
</table>

Compare the mean of these grouped data to the U.S. mean of $21.97.

14. Automobile Fuel Efficiency Thirty automobiles were tested for fuel efficiency (in miles per gallon). This frequency distribution was obtained. (The data in this exercise will be used in Exercise 20 in Section 3–2.)

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.5–12.5</td>
<td>3</td>
</tr>
<tr>
<td>12.5–17.5</td>
<td>5</td>
</tr>
<tr>
<td>17.5–22.5</td>
<td>15</td>
</tr>
<tr>
<td>22.5–27.5</td>
<td>5</td>
</tr>
<tr>
<td>27.5–32.5</td>
<td>2</td>
</tr>
</tbody>
</table>
15. **Percentage of Foreign-Born People**  The percentage of foreign-born population for each of the 50 states is represented below. Find the mean and modal class. Do you think the mean is the best average for this set of data? Explain.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8–4.4</td>
<td>26</td>
</tr>
<tr>
<td>4.5–8.1</td>
<td>11</td>
</tr>
<tr>
<td>8.2–11.8</td>
<td>4</td>
</tr>
<tr>
<td>11.9–15.5</td>
<td>5</td>
</tr>
<tr>
<td>15.6–19.2</td>
<td>2</td>
</tr>
<tr>
<td>19.3–22.9</td>
<td>1</td>
</tr>
<tr>
<td>23.0–26.6</td>
<td>1</td>
</tr>
</tbody>
</table>

Source: *World Almanac.*

16. Find the mean and modal class for each set of data in Exercises 8 and 18 in Section 2–2. Is the average about the same for both sets of data?

17. **Percentage of College-Educated Population over 25**  Below are the percentages of the population over 25 years of age who have completed 4 years of college or more for the 50 states and the District of Columbia. Find the mean and modal class.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.2–19.6</td>
<td>3</td>
</tr>
<tr>
<td>19.7–24.1</td>
<td>15</td>
</tr>
<tr>
<td>24.2–28.6</td>
<td>19</td>
</tr>
<tr>
<td>28.7–33.1</td>
<td>6</td>
</tr>
<tr>
<td>33.2–37.6</td>
<td>7</td>
</tr>
<tr>
<td>37.7–42.1</td>
<td>0</td>
</tr>
<tr>
<td>42.2–46.6</td>
<td>1</td>
</tr>
</tbody>
</table>


18. **Net Worth of Corporations**  These data represent the net worth (in millions of dollars) of 45 national corporations.

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>10–20</td>
<td>2</td>
</tr>
<tr>
<td>21–31</td>
<td>8</td>
</tr>
<tr>
<td>32–42</td>
<td>15</td>
</tr>
<tr>
<td>43–53</td>
<td>7</td>
</tr>
<tr>
<td>54–64</td>
<td>10</td>
</tr>
<tr>
<td>65–75</td>
<td>3</td>
</tr>
</tbody>
</table>

19. **Cost per Load of Laundry Detergents**  The cost per load (in cents) of 35 laundry detergents tested by a consumer organization is shown. (The data in this exercise will be used for Exercise 19 in Section 3–2.)

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>13–19</td>
<td>2</td>
</tr>
<tr>
<td>20–26</td>
<td>7</td>
</tr>
<tr>
<td>27–33</td>
<td>12</td>
</tr>
<tr>
<td>34–40</td>
<td>5</td>
</tr>
<tr>
<td>41–47</td>
<td>6</td>
</tr>
<tr>
<td>48–54</td>
<td>1</td>
</tr>
<tr>
<td>55–61</td>
<td>0</td>
</tr>
<tr>
<td>62–68</td>
<td>2</td>
</tr>
</tbody>
</table>

20. **Commissions Earned**  This frequency distribution represents the commission earned (in dollars) by 100 salespeople employed at several branches of a large chain store.

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>150–158</td>
<td>5</td>
</tr>
<tr>
<td>159–167</td>
<td>16</td>
</tr>
<tr>
<td>168–176</td>
<td>20</td>
</tr>
<tr>
<td>177–185</td>
<td>21</td>
</tr>
<tr>
<td>186–194</td>
<td>20</td>
</tr>
<tr>
<td>195–203</td>
<td>15</td>
</tr>
<tr>
<td>204–212</td>
<td>3</td>
</tr>
</tbody>
</table>

21. **Copier Service Calls**  This frequency distribution represents the data obtained from a sample of 75 copying machine service technicians. The values represent the days between service calls for various copying machines.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.5–18.5</td>
<td>14</td>
</tr>
<tr>
<td>18.5–21.5</td>
<td>12</td>
</tr>
<tr>
<td>21.5–24.5</td>
<td>18</td>
</tr>
<tr>
<td>24.5–27.5</td>
<td>10</td>
</tr>
<tr>
<td>27.5–30.5</td>
<td>15</td>
</tr>
<tr>
<td>30.5–33.5</td>
<td>6</td>
</tr>
</tbody>
</table>

22. Use the data from Exercise 14 in Section 2–1 and find the mean and modal class.

23. Find the mean and modal class for the data in Exercise 13 in Section 2–1.

24. Use the data from Exercise 3 in Section 2–2 and find the mean and modal class.

### 25. Enrollments for Selected Independent Religiously Controlled 4-Year Colleges

Listed below are the enrollments for selected independent religiously controlled 4-year colleges which offer bachelor’s degrees only. Construct a grouped frequency distribution with six classes and find the mean and modal class.

1013 1867 1268 1666 2309 1231 3005 2895 2166 1136
1532 1461 1750 1069 1723 1827 1155 1714 2391 2155
1412 1688 2471 1759 3008 2511 2577 1082 1067 1062
1319 1037 2400

26. Find the weighted mean price of three models of automobiles sold. The number and price of each model sold are shown in this list.

<table>
<thead>
<tr>
<th>Model</th>
<th>Number</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>8</td>
<td>$10,000</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>12,000</td>
</tr>
<tr>
<td>C</td>
<td>12</td>
<td>8,000</td>
</tr>
</tbody>
</table>

27. Fat Grams Using the weighted mean, find the average number of grams of fat per ounce of meat or fish that a person would consume over a 5-day period if he ate these:

<table>
<thead>
<tr>
<th>Meat or fish</th>
<th>Fat (g/oz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 oz fried shrimp</td>
<td>3.33</td>
</tr>
<tr>
<td>3 oz veal cutlet</td>
<td>3.00</td>
</tr>
<tr>
<td>2 oz roast beef</td>
<td>2.50</td>
</tr>
<tr>
<td>2.5 oz fried chicken</td>
<td>4.40</td>
</tr>
<tr>
<td>4 oz tuna</td>
<td>1.75</td>
</tr>
</tbody>
</table>


28. Diet Cola Preference A recent survey of a new diet cola reported the following percentages of people who liked the taste. Find the weighted mean of the percentages.

<table>
<thead>
<tr>
<th>Area</th>
<th>% Favored</th>
<th>Number surveyed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>40</td>
<td>1000</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>3000</td>
</tr>
<tr>
<td>3</td>
<td>50</td>
<td>800</td>
</tr>
</tbody>
</table>

29. Costs of Helicopters The costs of three models of helicopters are shown here. Find the weighted mean of the costs of the models.

<table>
<thead>
<tr>
<th>Model</th>
<th>Number sold</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sunscraper</td>
<td>9</td>
<td>$427,000</td>
</tr>
<tr>
<td>Skycoaster</td>
<td>6</td>
<td>365,000</td>
</tr>
<tr>
<td>High-flyer</td>
<td>12</td>
<td>725,000</td>
</tr>
</tbody>
</table>

30. Final Grade An instructor grades exams, 20%; term paper, 30%; final exam, 50%. A student had grades of 83, 72, and 90, respectively, for exams, term paper, and final exam. Find the student’s final average. Use the weighted mean.

31. Final Grade Another instructor gives four 1-hour exams and one final exam, which counts as two 1-hour exams. Find a student’s grade if she received 62, 83, 97, and 90 on the 1-hour exams and 82 on the final exam.

32. For these situations, state which measure of central tendency—mean, median, or mode—should be used.

a. The most typical case is desired.
b. The distribution is open-ended.
c. There is an extreme value in the data set.
d. The data are categorical.
e. Further statistical computations will be needed.
f. The values are to be divided into two approximately equal groups, one group containing the larger values and one containing the smaller values.

33. Describe which measure of central tendency—mean, median, or mode—was probably used in each situation.

a. One-half of the factory workers make more than $5.37 per hour, and one-half make less than $5.37 per hour.
b. The average number of children per family in the Plaza Heights Complex is 1.8.
c. Most people prefer red convertibles over any other color.
d. The average person cuts the lawn once a week.
e. The most common fear today is fear of speaking in public.
f. The average age of college professors is 42.3 years.

34. What types of symbols are used to represent sample statistics? Give an example. What types of symbols are used to represent population parameters? Give an example.

35. A local fast-food company claims that the average salary of its employees is $13.23 per hour. An employee states that most employees make minimum wage. If both are being truthful, how could both be correct?

36. If the mean of five values is 64, find the sum of the values.

37. If the mean of five values is 8.2 and four of the values are 6, 10, 7, and 12, find the fifth value.

38. Find the mean of 10, 20, 30, 40, and 50.
   a. Add 10 to each value and find the mean.
   b. Subtract 10 from each value and find the mean.
   c. Multiply each value by 10 and find the mean.
   d. Divide each value by 10 and find the mean.
   e. Make a general statement about each situation.

39. The harmonic mean (HM) is defined as the number of values divided by the sum of the reciprocals of each value. The formula is

\[ HM = \frac{n}{\sum (1/X)} \]
For example, the harmonic mean of 1, 4, 5, and 2 is

\[
HM = \frac{4}{1/1 + 1/4 + 1/5 + 1/2} = 2.05
\]

This mean is useful for finding the average speed. Suppose a person drove 100 miles at 40 miles per hour and returned driving 50 miles per hour. The average miles per hour is not 45 miles per hour, which is found by adding 40 and 50 and dividing by 2. The average is found as shown.

Since

\[
Time = \frac{distance}{rate}
\]

then

\[
Time 1 = \frac{100}{40} = 2.5 \text{ hours to make the trip}
\]

\[
Time 2 = \frac{100}{50} = 2 \text{ hours to return}
\]

Hence, the total time is 4.5 hours, and the total miles driven are 200. Now, the average speed is

\[
Rate = \frac{distance}{time} = \frac{200}{4.5} = 44.44 \text{ miles per hour}
\]

This value can also be found by using the harmonic mean formula

\[
HM = \frac{2}{1/40 + 1/50} = 44.44
\]

Using the harmonic mean, find each of these.

a. A salesperson drives 300 miles round trip at 30 miles per hour going to Chicago and 45 miles per hour returning home. Find the average miles per hour.

b. A bus driver drives the 50 miles to West Chester at 40 miles per hour and returns driving 25 miles per hour. Find the average miles per hour.

c. A carpenter buys $500 worth of nails at $50 per pound and $500 worth of nails at $10 per pound. Find the average cost of 1 pound of nails.

40. The geometric mean (GM) is defined as the nth root of the product of n values. The formula is

\[
GM = \sqrt[n]{(x_1)(x_2)(x_3)\cdots(x_n)}
\]

The geometric mean of 4 and 16 is

\[
GM = \sqrt[4]{4(16)} = \sqrt{64} = 8
\]

The geometric mean of 1, 3, and 9 is

\[
GM = \sqrt[3]{1(3)(9)} = \sqrt[3]{27} = 3
\]

The geometric mean is useful in finding the average of percentages, ratios, indexes, or growth rates. For example, if a person receives a 20% raise after 1 year of service and a 10% raise after the second year of service, the average percentage raise per year is not 15 but 14.89%, as shown.

\[
GM = \sqrt[2]{1.2\times1.1} = 1.1489
\]

or

\[
GM = \sqrt[2]{(1.2)(1.1)} = 114.89%
\]

His salary is 120% at the end of the first year and 110% at the end of the second year. This is equivalent to an average of 14.89%, since 114.89% - 100% = 14.89%.

This answer can also be shown by assuming that the person makes $10,000 to start and receives two raises of 20% and 10%.

Raise 1 = 10,000 \cdot 20\% = $2000

Raise 2 = 12,000 \cdot 10\% = $1200

His total salary raise is $3200. This total is equivalent to

\[
\begin{align*}
$10,000 & \cdot 14.89\% = $1489.00 \\
$11,489 & \cdot 14.89\% = 1710.71 \\
$3199.71 & = \approx $3200
\end{align*}
\]

Find the geometric mean of each of these.

a. The growth rates of the Living Life Insurance Corporation for the past 3 years were 35, 24, and 18%.

b. A person received these percentage raises in salary over a 4-year period: 8, 6, 4, and 5%.

c. A stock increased each year for 5 years at these percentages: 10, 8, 12, 9, and 3%.

d. The price increases, in percentages, for the cost of food in a specific geographic region for the past 3 years were 1, 3, and 5.5%.

41. A useful mean in the physical sciences (such as voltage) is the quadratic mean (QM), which is found by taking the square root of the average of the squares of each value. The formula is

\[
QM = \sqrt{\frac{\sum X^2}{n}}
\]

The quadratic mean of 3, 5, 6, and 10 is

\[
QM = \sqrt{\frac{3^2 + 5^2 + 6^2 + 10^2}{4}}
\]

\[
= \sqrt{25} = 6.52
\]

Find the quadratic mean of 8, 6, 3, 5, and 4.

42. An approximate median can be found for data that have been grouped into a frequency distribution. First it is necessary to find the median class. This is the class that contains the median value. That is the n/2 data value. Then it is assumed that the data values are evenly distributed throughout the median class. The formula is

\[
MD = \frac{n}{2} - \frac{cf}{f}(w) + L_m
\]

where

- \( n \) = sum of frequencies
- \( cf \) = cumulative frequency of class immediately preceding the median class
- \( w \) = width of median class
- \( f \) = frequency of median class
- \( L_m \) = lower boundary of median class

Using this formula, find the median for data in the frequency distribution of Exercise 15.
Finding Measures of Central Tendency

Example XL3–1

Find the mean, mode, and median of the data from Example 3–11. The data represent the population of licensed nuclear reactors in the United States for a recent 15-year period.

1. 104 104 104 104 104
2. 107 109 109 109 110
3. 109 111 112 111 109


On the same worksheet as the data:

2. Compute the mean of the data: key in =AVERAGE(A2:A16) in a blank cell.

3. Compute the mode of the data: key in =MODE(A2:A16) in a blank cell.

4. Compute the median of the data: key in =MEDIAN(A2:A16) in a blank cell.

These and other statistical functions can also be accessed without typing them into the worksheet directly.

1. Select the Formulas tab from the toolbar and select the Insert Function Icon.

2. Select the Statistical category for statistical functions.

3. Scroll to find the appropriate function and click [OK].

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of Reactors</td>
<td>104</td>
</tr>
<tr>
<td>2</td>
<td>107.7333 mean</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>104</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>104 mode</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>105 median</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>109</td>
<td></td>
</tr>
</tbody>
</table>

**3–2 Measures of Variation**

In statistics, to describe the data set accurately, statisticians must know more than the measures of central tendency. Consider Example 3–18.

**Example 3–18**

Comparison of Outdoor Paint

A testing lab wishes to test two experimental brands of outdoor paint to see how long each will last before fading. The testing lab makes 6 gallons of each paint to test. Since different chemical agents are added to each group and only six cans are involved, these two groups constitute two small populations. The results (in months) are shown. Find the mean of each group.
Chapter 3  Data Description

<table>
<thead>
<tr>
<th>Brand A</th>
<th>Brand B</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>35</td>
</tr>
<tr>
<td>60</td>
<td>45</td>
</tr>
<tr>
<td>50</td>
<td>30</td>
</tr>
<tr>
<td>30</td>
<td>35</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>20</td>
<td>25</td>
</tr>
</tbody>
</table>

Solution

The mean for brand A is

\[ \mu = \frac{\sum X}{N} = \frac{210}{6} = 35 \text{ months} \]

The mean for brand B is

\[ \mu = \frac{\sum X}{N} = \frac{210}{6} = 35 \text{ months} \]

Since the means are equal in Example 3–18, you might conclude that both brands of paint last equally well. However, when the data sets are examined graphically, a somewhat different conclusion might be drawn. See Figure 3–2.

As Figure 3–2 shows, even though the means are the same for both brands, the spread, or variation, is quite different. Figure 3–2 shows that brand B performs more consistently; it is less variable. For the spread or variability of a data set, three measures are commonly used: range, variance, and standard deviation. Each measure will be discussed in this section.

Range

The range is the simplest of the three measures and is defined now.

The range is the highest value minus the lowest value. The symbol \( R \) is used for the range.

\[ R = \text{highest value} - \text{lowest value} \]

![Figure 3–2](examining-data-sets-graphically.png)

Variation of paint (in months)

(a) Brand A

Variation of paint (in months)

(b) Brand B

3–22
Example 3–19  
**Comparison of Outdoor Paint**

Find the ranges for the paints in Example 3–18.

**Solution**

For brand A, the range is

\[ R = 60 - 10 = 50 \text{ months} \]

For brand B, the range is

\[ R = 45 - 25 = 20 \text{ months} \]

Make sure the range is given as a single number.

The range for brand A shows that 50 months separate the largest data value from the smallest data value. For brand B, 20 months separate the largest data value from the smallest data value, which is less than one-half of brand A’s range.

One extremely high or one extremely low data value can affect the range markedly, as shown in Example 3–20.

Example 3–20  
**Employee Salaries**

The salaries for the staff of the XYZ Manufacturing Co. are shown here. Find the range.

<table>
<thead>
<tr>
<th>Staff</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>$100,000</td>
</tr>
<tr>
<td>Manager</td>
<td>40,000</td>
</tr>
<tr>
<td>Sales representative</td>
<td>30,000</td>
</tr>
<tr>
<td>Workers</td>
<td>25,000</td>
</tr>
<tr>
<td></td>
<td>15,000</td>
</tr>
<tr>
<td></td>
<td>18,000</td>
</tr>
</tbody>
</table>

**Solution**

The range is \[ R = 100,000 - 15,000 = 85,000 \].

Since the owner’s salary is included in the data for Example 3–20, the range is a large number. To have a more meaningful statistic to measure the variability, statisticians use measures called the *variance* and *standard deviation*.

**Population Variance and Standard Deviation**

Before the variance and standard deviation are defined formally, the computational procedure will be shown, since the definition is derived from the procedure.

**Rounding Rule for the Standard Deviation** The rounding rule for the standard deviation is the same as that for the mean. The final answer should be rounded to one more decimal place than that of the original data.

Example 3–21  
**Comparison of Outdoor Paint**

Find the variance and standard deviation for the data set for brand A paint in Example 3–18.

10, 60, 50, 30, 40, 20
Solution

**Step 1** Find the mean for the data.

\[
\mu = \frac{\sum X}{N} = \frac{10 + 60 + 50 + 30 + 40 + 20}{6} = \frac{210}{6} = 35
\]

**Step 2** Subtract the mean from each data value.

\[
10 - 35 = -25 \quad 50 - 35 = +15 \quad 40 - 35 = +5 \\
60 - 35 = +25 \quad 30 - 35 = -5 \quad 20 - 35 = -15
\]

**Step 3** Square each result.

\[
(-25)^2 = 625 \quad (+15)^2 = 225 \quad (+5)^2 = 25 \\
(+25)^2 = 625 \quad (-5)^2 = 25 \quad (-15)^2 = 225
\]

**Step 4** Find the sum of the squares.

\[
625 + 625 + 225 + 25 + 225 + 1750 = 1750
\]

**Step 5** Divide the sum by \( N \) to get the variance.

Variance = \( \frac{1750}{6} = 291.7 \)

**Step 6** Take the square root of the variance to get the standard deviation. Hence, the standard deviation equals \( \sqrt{291.7} \), or 17.1. It is helpful to make a table.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Values ( X )</td>
<td>( X - \mu )</td>
<td>((X - \mu)^2)</td>
</tr>
<tr>
<td>10</td>
<td>−25</td>
<td>625</td>
</tr>
<tr>
<td>60</td>
<td>+25</td>
<td>625</td>
</tr>
<tr>
<td>50</td>
<td>+15</td>
<td>225</td>
</tr>
<tr>
<td>30</td>
<td>−5</td>
<td>25</td>
</tr>
<tr>
<td>40</td>
<td>+5</td>
<td>25</td>
</tr>
<tr>
<td>20</td>
<td>−15</td>
<td>225</td>
</tr>
</tbody>
</table>

Column A contains the raw data \( X \). Column B contains the differences \( X - \mu \) obtained in step 2. Column C contains the squares of the differences obtained in step 3.

The preceding computational procedure reveals several things. First, the square root of the variance gives the standard deviation; and vice versa, squaring the standard deviation gives the variance. Second, the variance is actually the average of the square of the distance that each value is from the mean. Therefore, if the values are near the mean, the variance will be small. In contrast, if the values are far from the mean, the variance will be large.

You might wonder why the squared distances are used instead of the actual distances. One reason is that the sum of the distances will always be zero. To verify this result for a specific case, add the values in column B of the table in Example 3–21. When each value is squared, the negative signs are eliminated.

Finally, why is it necessary to take the square root? The reason is that since the distances were squared, the units of the resultant numbers are the squares of the units of the original raw data. Finding the square root of the variance puts the standard deviation in the same units as the raw data.

When you are finding the square root, always use its positive or principal value, since the variance and standard deviation of a data set can never be negative.
The **variance** is the average of the squares of the distance each value is from the mean. The symbol for the population variance is \( \sigma^2 \) (\( \sigma \) is the Greek lowercase letter sigma).

The formula for the population variance is

\[
\sigma^2 = \frac{\sum (X - \mu)^2}{N}
\]

where

- \( X \) = individual value
- \( \mu \) = population mean
- \( N \) = population size

The **standard deviation** is the square root of the variance. The symbol for the population standard deviation is \( \sigma \).

The corresponding formula for the population standard deviation is

\[
\sigma = \sqrt{\sigma^2} = \sqrt{\frac{\sum (X - \mu)^2}{N}}
\]

### Example 3–22

**Comparison of Outdoor Paint**

Find the variance and standard deviation for brand B paint data in Example 3–18. The months were 35, 45, 30, 35, 40, 25.

**Solution**

**Step 1** Find the mean.

\[
\mu = \frac{\sum X}{N} = \frac{35 + 45 + 30 + 35 + 40 + 25}{6} = \frac{210}{6} = 35
\]

**Step 2** Subtract the mean from each value, and place the result in column B of the table.

**Step 3** Square each result and place the squares in column C of the table.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>( X - \mu )</td>
<td>( (X - \mu)^2 )</td>
</tr>
<tr>
<td>35</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>45</td>
<td>10</td>
<td>100</td>
</tr>
<tr>
<td>30</td>
<td>-5</td>
<td>25</td>
</tr>
<tr>
<td>35</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>40</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>25</td>
<td>-10</td>
<td>100</td>
</tr>
</tbody>
</table>

**Step 4** Find the sum of the squares in column C.

\[
\sum (X - \mu)^2 = 0 + 100 + 25 + 0 + 25 + 100 = 250
\]

**Step 5** Divide the sum by \( N \) to get the variance.

\[
\sigma^2 = \frac{\sum (X - \mu)^2}{N} = \frac{250}{6} = 41.7
\]

**Step 6** Take the square root to get the standard deviation.

\[
\sigma = \sqrt{\frac{\sum (X - \mu)^2}{N}} = \sqrt{41.7} = 6.5
\]

Hence, the standard deviation is 6.5.
Since the standard deviation of brand A is 17.1 (see Example 3–21) and the standard deviation of brand B is 6.5, the data are more variable for brand A. In summary, when the means are equal, the larger the variance or standard deviation is, the more variable the data are.

**Sample Variance and Standard Deviation**

When computing the variance for a sample, one might expect the following expression to be used:

\[
\frac{\sum (X - \overline{X})^2}{n}
\]

where \( \overline{X} \) is the sample mean and \( n \) is the sample size. This formula is not usually used, however, since in most cases the purpose of calculating the statistic is to estimate the corresponding parameter. For example, the sample mean \( \overline{X} \) is used to estimate the population mean \( \mu \). The expression

\[
\frac{\sum (X - \overline{X})^2}{n}
\]

does not give the best estimate of the population variance because when the population is large and the sample is small (usually less than 30), the variance computed by this formula usually underestimates the population variance. Therefore, instead of dividing by \( n \), find the variance of the sample by dividing by \( n - 1 \), giving a slightly larger value and an unbiased estimate of the population variance.

The formula for the sample variance, denoted by \( s^2 \), is

\[
s^2 = \frac{\sum (X - \overline{X})^2}{n - 1}
\]

where

- \( \overline{X} \) = sample mean
- \( n \) = sample size

To find the standard deviation of a sample, you must take the square root of the sample variance, which was found by using the preceding formula.

**Formula for the Sample Standard Deviation**

The standard deviation of a sample (denoted by \( s \)) is

\[
s = \sqrt{s^2} = \sqrt{\frac{\sum (X - \overline{X})^2}{n - 1}}
\]

where

- \( X \) = individual value
- \( \overline{X} \) = sample mean
- \( n \) = sample size

Shortcut formulas for computing the variance and standard deviation are presented next and will be used in the remainder of the chapter and in the exercises. These formulas are mathematically equivalent to the preceding formulas and do not involve using the mean. They save time when repeated subtracting and squaring occur in the original formulas. They are also more accurate when the mean has been rounded.
Shortcut or Computational Formulas for $s^2$ and $s$

The shortcut formulas for computing the variance and standard deviation for data obtained from samples are as follows.

<table>
<thead>
<tr>
<th>Variance</th>
<th>Standard deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$s^2 = \frac{n(\Sigma X^2) - (\Sigma X)^2}{n(n - 1)}$</td>
<td>$s = \sqrt{\frac{n(\Sigma X^2) - (\Sigma X)^2}{n(n - 1)}}$</td>
</tr>
</tbody>
</table>

Examples 3–23 and 3–24 explain how to use the shortcut formulas.

Example 3–23

**European Auto Sales**

Find the sample variance and standard deviation for the amount of European auto sales for a sample of 6 years shown. The data are in millions of dollars.

11.2, 11.9, 12.0, 12.8, 13.4, 14.3

Source: USA TODAY.

**Solution**

**Step 1** Find the sum of the values.

$\Sigma X = 11.2 + 11.9 + 12.0 + 12.8 + 13.4 + 14.3 = 75.6$

**Step 2** Square each value and find the sum.

$\Sigma X^2 = 11.2^2 + 11.9^2 + 12.0^2 + 12.8^2 + 13.4^2 + 14.3^2 = 958.94$

**Step 3** Substitute in the formulas and solve.

$s^2 = \frac{n(\Sigma X^2) - (\Sigma X)^2}{n(n - 1)}$

$= \frac{6(958.94) - 75.6^2}{6(6 - 1)}$

$= \frac{5753.64 - 5715.36}{6(5)}$

$= \frac{38.28}{30}$

$= 1.276$

The variance is 1.28 rounded.

$s = \sqrt{1.28} = 1.13$

Hence, the sample standard deviation is 1.13.

*Note that $\Sigma X^2$ is not the same as $(\Sigma X)^2$. The notation $\Sigma X^2$ means to square the values first, then sum; $(\Sigma X)^2$ means to sum the values first, then square the sum.*

**Variance and Standard Deviation for Grouped Data**

The procedure for finding the variance and standard deviation for grouped data is similar to that for finding the mean for grouped data, and it uses the midpoints of each class.
Example 3–24

Miles Run per Week

Find the variance and the standard deviation for the frequency distribution of the data in Example 2–7. The data represent the number of miles that 20 runners ran during one week.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
<th>Midpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5–10.5</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>10.5–15.5</td>
<td>2</td>
<td>13</td>
</tr>
<tr>
<td>15.5–20.5</td>
<td>3</td>
<td>18</td>
</tr>
<tr>
<td>20.5–25.5</td>
<td>5</td>
<td>23</td>
</tr>
<tr>
<td>25.5–30.5</td>
<td>4</td>
<td>28</td>
</tr>
<tr>
<td>30.5–35.5</td>
<td>3</td>
<td>33</td>
</tr>
<tr>
<td>35.5–40.5</td>
<td>2</td>
<td>38</td>
</tr>
</tbody>
</table>

Solution

Step 1 Make a table as shown, and find the midpoint of each class.

\[
\begin{array}{ccc}
A & B & C \\
\text{Class} & \text{Frequency} & \text{Midpoint} \\
5.5–10.5 & 1 & 8 \\
10.5–15.5 & 2 & 13 \\
15.5–20.5 & 3 & 18 \\
20.5–25.5 & 5 & 23 \\
25.5–30.5 & 4 & 28 \\
30.5–35.5 & 3 & 33 \\
35.5–40.5 & 2 & 38 \\
\end{array}
\]

Step 2 Multiply the frequency by the midpoint for each class, and place the products in column D.

1 \cdot 8 = 8 \\
2 \cdot 13 = 26 \\
\ldots \\
2 \cdot 38 = 76

Step 3 Multiply the frequency by the square of the midpoint, and place the products in column E.

1 \cdot 8^2 = 64 \\
2 \cdot 13^2 = 338 \\
\ldots \\
2 \cdot 38^2 = 2888

Step 4 Find the sums of columns B, D, and E. The sum of column B is \( n \), the sum of column D is \( \sum f \cdot X_m \), and the sum of column E is \( \sum f \cdot X^2_m \). The completed table is shown.

\[
\begin{array}{cccc}
A & B & C & D \\
\text{Class} & \text{Frequency} & \text{Midpoint} & \text{ } & \text{ } \text{ } \text{ } \\
5.5–10.5 & 1 & 8 & 8 & 64 \\
10.5–15.5 & 2 & 13 & 26 & 338 \\
15.5–20.5 & 3 & 18 & 54 & 972 \\
20.5–25.5 & 5 & 23 & 115 & 2,645 \\
25.5–30.5 & 4 & 28 & 112 & 3,136 \\
30.5–35.5 & 3 & 33 & 99 & 3,267 \\
35.5–40.5 & 2 & 38 & 76 & 2,888 \\
\end{array}
\]

\[ n = 20 \quad \sum f \cdot X_m = 490 \quad \sum f \cdot X^2_m = 13,310 \]
Step 5 Substitute in the formula and solve for $s^2$ to get the variance.

$$
\frac{\bar{x} \cdot \sum f \cdot X_m - (\sum f \cdot X_m)^2}{\bar{x} \cdot n(n - 1)}
$$

$$
= \frac{20(\sum f \cdot X_m - 490^2)}{20(20 - 1)}
$$

$$
= \frac{266,200 - 240,100}{380}
$$

$$
= \frac{26,100}{380} = 68.7
$$

Step 6 Take the square root to get the standard deviation.

$$
s = \sqrt{68.7} = 8.3
$$

Be sure to use the number found in the sum of column B (i.e., the sum of the frequencies) for $n$. Do not use the number of classes.

The steps for finding the variance and standard deviation for grouped data are summarized in this Procedure Table.

### Procedure Table

**Finding the Sample Variance and Standard Deviation for Grouped Data**

- **Step 1** Make a table as shown, and find the midpoint of each class.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>Frequency</td>
<td>Midpoint</td>
<td>$f \cdot X_m$</td>
<td>$f \cdot X_m^2$</td>
</tr>
</tbody>
</table>

- **Step 2** Multiply the frequency by the midpoint for each class, and place the products in column D.

- **Step 3** Multiply the frequency by the square of the midpoint, and place the products in column E.

- **Step 4** Find the sums of columns B, D, and E. (The sum of column B is $n$. The sum of column D is $\sum f \cdot X_m$. The sum of column E is $\sum f \cdot X_m^2$.)

- **Step 5** Substitute in the formula and solve to get the variance.

$$
\frac{n(\sum f \cdot X_m^2) - (\sum f \cdot X_m)^2}{n(n - 1)}
$$

- **Step 6** Take the square root to get the standard deviation.

The three measures of variation are summarized in Table 3–2.

### Table 3–2 Summary of Measures of Variation

<table>
<thead>
<tr>
<th>Measure</th>
<th>Definition</th>
<th>Symbol(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>Distance between highest value and lowest value</td>
<td>$R$</td>
</tr>
<tr>
<td>Variance</td>
<td>Average of the squares of the distance that each value is from the mean</td>
<td>$\sigma^2$, $s^2$</td>
</tr>
<tr>
<td>Standard deviation</td>
<td>Square root of the variance</td>
<td>$\sigma$, $s$</td>
</tr>
</tbody>
</table>
Uses of the Variance and Standard Deviation

1. As previously stated, variances and standard deviations can be used to determine the spread of the data. If the variance or standard deviation is large, the data are more dispersed. This information is useful in comparing two (or more) data sets to determine which is more (most) variable.

2. The measures of variance and standard deviation are used to determine the consistency of a variable. For example, in the manufacture of fittings, such as nuts and bolts, the variation in the diameters must be small, or the parts will not fit together.

3. The variance and standard deviation are used to determine the number of data values that fall within a specified interval in a distribution. For example, Chebyshev’s theorem (explained later) shows that, for any distribution, at least 75% of the data values will fall within 2 standard deviations of the mean.

4. Finally, the variance and standard deviation are used quite often in inferential statistics. These uses will be shown in later chapters of this textbook.

Coefficient of Variation

Whenever two samples have the same units of measure, the variance and standard deviation for each can be compared directly. For example, suppose an automobile dealer wanted to compare the standard deviation of miles driven for the cars she received as trade-ins on new cars. She found that for a specific year, the standard deviation for Buicks was 422 miles and the standard deviation for Cadillacs was 350 miles. She could say that the variation in mileage was greater in the Buicks. But what if a manager wanted to compare the standard deviations of two different variables, such as the number of sales per salesperson over a 3-month period and the commissions made by these salespeople?

A statistic that allows you to compare standard deviations when the units are different, as in this example, is called the coefficient of variation.

The coefficient of variation, denoted by CVar, is the standard deviation divided by the mean. The result is expressed as a percentage.

\[
\text{CVar} = \frac{s}{\mu} \cdot 100\%
\]

For samples, For populations,

\[
\text{CVar} = \frac{s}{X} \cdot 100\%
\]

For populations, \[
\text{CVar} = \frac{\sigma}{\mu} \cdot 100\%
\]

Example 3–25 Sales of Automobiles

The mean of the number of sales of cars over a 3-month period is 87, and the standard deviation is 5. The mean of the commissions is $5225, and the standard deviation is $773. Compare the variations of the two.

Solution

The coefficients of variation are

\[
\text{CVar} = \frac{s}{X} = \frac{5}{87} \cdot 100\% = 5.7\% \quad \text{sales}
\]

\[
\text{CVar} = \frac{\sigma}{\mu} = \frac{773}{5225} \cdot 100\% = 14.8\% \quad \text{commissions}
\]

Since the coefficient of variation is larger for commissions, the commissions are more variable than the sales.
Example 3–26  Pages in Women’s Fitness Magazines

The mean for the number of pages of a sample of women’s fitness magazines is 132, with a variance of 23; the mean for the number of advertisements of a sample of women’s fitness magazines is 182, with a variance of 62. Compare the variations.

Solution

The coefficients of variation are

\[ C_{Var} = \frac{\sqrt{23}}{132} \cdot 100\% = 3.6\% \quad \text{pages} \]

\[ C_{Var} = \frac{\sqrt{62}}{182} \cdot 100\% = 4.3\% \quad \text{advertisements} \]

The number of advertisements is more variable than the number of pages since the coefficient of variation is larger for advertisements.

Range Rule of Thumb

The range can be used to approximate the standard deviation. The approximation is called the range rule of thumb.

The Range Rule of Thumb

A rough estimate of the standard deviation is

\[ s \approx \frac{\text{range}}{4} \]

In other words, if the range is divided by 4, an approximate value for the standard deviation is obtained. For example, the standard deviation for the data set 5, 8, 8, 9, 10, 12, and 13 is 2.7, and the range is 13 − 5 = 8. The range rule of thumb is \( s \approx 2 \). The range rule of thumb in this case underestimates the standard deviation somewhat; however, it is in the ballpark.

A note of caution should be mentioned here. The range rule of thumb is only an approximation and should be used when the distribution of data values is unimodal and roughly symmetric.

The range rule of thumb can be used to estimate the largest and smallest data values of a data set. The smallest data value will be approximately 2 standard deviations below the mean, and the largest data value will be approximately 2 standard deviations above the mean of the data set. The mean for the previous data set is 9.3; hence,

Smallest data value = \( \bar{X} - 2s = 9.3 - 2(2.8) = 3.7 \)

Largest data value = \( \bar{X} + 2s = 9.3 + 2(2.8) = 14.9 \)

Notice that the smallest data value was 5, and the largest data value was 13. Again, these are rough approximations. For many data sets, almost all data values will fall within 2 standard deviations of the mean. Better approximations can be obtained by using Chebyshev’s theorem and the empirical rule. These are explained next.
Chebyshev’s Theorem

As stated previously, the variance and standard deviation of a variable can be used to determine the spread, or dispersion, of a variable. That is, the larger the variance or standard deviation, the more the data values are dispersed. For example, if two variables measured in the same units have the same mean, say, 70, and the first variable has a standard deviation of 1.5 while the second variable has a standard deviation of 10, then the data for the second variable will be more spread out than the data for the first variable. Chebyshev’s theorem, developed by the Russian mathematician Chebyshev (1821–1894), specifies the proportions of the spread in terms of the standard deviation.

Chebyshev’s theorem

The proportion of values from a data set that will fall within $k$ standard deviations of the mean will be at least $1 - 1/k^2$, where $k$ is a number greater than 1 ($k$ is not necessarily an integer).

This theorem states that at least three-fourths, or 75%, of the data values will fall within 2 standard deviations of the mean of the data set. This result is found by substituting $k = 2$ in the expression.

$$1 - \frac{1}{k^2} \quad \text{or} \quad 1 - \frac{1}{2^2} = 1 - \frac{1}{4} = \frac{3}{4} = 75\%$$

For the example in which variable 1 has a mean of 70 and a standard deviation of 1.5, at least three-fourths, or 75%, of the data values fall between 67 and 73. These values are found by adding 2 standard deviations to the mean and subtracting 2 standard deviations from the mean, as shown:

$$70 + 2(1.5) = 70 + 3 = 73$$

and

$$70 - 2(1.5) = 70 - 3 = 67$$

For variable 2, at least three-fourths, or 75%, of the data values fall between 50 and 90. Again, these values are found by adding and subtracting, respectively, 2 standard deviations to and from the mean.

$$70 + 2(10) = 70 + 20 = 90$$

and

$$70 - 2(10) = 70 - 20 = 50$$

Furthermore, the theorem states that at least eight-ninths, or 88.89%, of the data values will fall within 3 standard deviations of the mean. This result is found by letting $k = 3$ and substituting in the expression.

$$1 - \frac{1}{k^2} \quad \text{or} \quad 1 - \frac{1}{3^2} = 1 - \frac{1}{9} = \frac{8}{9} = 88.89\%$$

For variable 1, at least eight-ninths, or 88.89%, of the data values fall between 65.5 and 74.5, since

$$70 + 3(1.5) = 70 + 4.5 = 74.5$$

and

$$70 - 3(1.5) = 70 - 4.5 = 65.5$$

For variable 2, at least eight-ninths, or 88.89%, of the data values fall between 40 and 100.
This theorem can be applied to any distribution regardless of its shape (see Figure 3–3). Examples 3–27 and 3–28 illustrate the application of Chebyshev’s theorem.

**Example 3–27**  
**Prices of Homes**

The mean price of houses in a certain neighborhood is $50,000, and the standard deviation is $10,000. Find the price range for which at least 75% of the houses will sell.

**Solution**

Chebyshev’s theorem states that three-fourths, or 75%, of the data values will fall within 2 standard deviations of the mean. Thus,

\[50,000 + 2(10,000) = 50,000 + 20,000 = 70,000\]

and

\[50,000 - 2(10,000) = 50,000 - 20,000 = 30,000\]

Hence, at least 75% of all homes sold in the area will have a price range from $30,000 to $70,000.

Chebyshev’s theorem can be used to find the minimum percentage of data values that will fall between any two given values. The procedure is shown in Example 3–28.

**Example 3–28**  
**Travel Allowances**

A survey of local companies found that the mean amount of travel allowance for executives was $0.25 per mile. The standard deviation was $0.02. Using Chebyshev’s theorem, find the minimum percentage of the data values that will fall between $0.20 and $0.30.
Solution

Step 1 Subtract the mean from the larger value.

\[ 0.30 - 0.25 = 0.05 \]

Step 2 Divide the difference by the standard deviation to get \( k \).

\[ k = \frac{0.05}{0.02} = 2.5 \]

Step 3 Use Chebyshev’s theorem to find the percentage.

\[ 1 - \frac{1}{k^2} = 1 - \frac{1}{2.5^2} = 1 - \frac{1}{6.25} = 1 - 0.16 = 0.84 \quad \text{or} \quad 84\% \]

Hence, at least 84% of the data values will fall between $0.20 and $0.30.

The Empirical (Normal) Rule

Chebyshev’s theorem applies to any distribution regardless of its shape. However, when a distribution is bell-shaped (or what is called normal), the following statements, which make up the empirical rule, are true.

- Approximately 68% of the data values will fall within 1 standard deviation of the mean.
- Approximately 95% of the data values will fall within 2 standard deviations of the mean.
- Approximately 99.7% of the data values will fall within 3 standard deviations of the mean.

For example, suppose that the scores on a national achievement exam have a mean of 480 and a standard deviation of 90. If these scores are normally distributed, then approximately 68% will fall between 390 and 570 (\( 480 + 90 = 570 \) and \( 480 - 90 = 390 \)). Approximately 95% of the scores will fall between 300 and 660 (\( 480 + 2 \cdot 90 = 660 \) and \( 480 - 2 \cdot 90 = 300 \)). Approximately 99.7% will fall between 210 and 750 (\( 480 + 3 \cdot 90 = 750 \) and \( 480 - 3 \cdot 90 = 210 \)). See Figure 3–4. (The empirical rule is explained in greater detail in Chapter 6.)
**Applying the Concepts 3–2**

**Blood Pressure**

The table lists means and standard deviations. The mean is the number before the plus/minus, and the standard deviation is the number after the plus/minus. The results are from a study attempting to find the average blood pressure of older adults. Use the results to answer the questions.

<table>
<thead>
<tr>
<th></th>
<th>Normotensive</th>
<th>Hypertensive</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Men (n = 1200)</td>
<td>Women (n = 1400)</td>
</tr>
<tr>
<td>Age Blood pressure (mm Hg)</td>
<td>55 ± 10</td>
<td>55 ± 10</td>
</tr>
<tr>
<td>Systolic</td>
<td>123 ± 9</td>
<td>121 ± 11</td>
</tr>
<tr>
<td>Diastolic</td>
<td>78 ± 7</td>
<td>76 ± 7</td>
</tr>
</tbody>
</table>

1. Apply Chebyshev’s theorem to the systolic blood pressure of normotensive men. At least how many of the men in the study fall within 1 standard deviation of the mean?
2. At least how many of those men in the study fall within 2 standard deviations of the mean?

Assume that blood pressure is normally distributed among older adults. Answer the following questions, using the empirical rule instead of Chebyshev’s theorem.

3. Give ranges for the diastolic blood pressure (normotensive and hypertensive) of older women.
4. Do the normotensive, male, systolic blood pressure ranges overlap with the hypertensive, male, systolic blood pressure ranges?

See page 180 for the answers.

---

**Exercises 3–2**

1. What is the relationship between the variance and the standard deviation?
2. Why might the range not be the best estimate of variability?
3. What are the symbols used to represent the population variance and standard deviation?
4. What are the symbols used to represent the sample variance and standard deviation?
5. Why is the unbiased estimator of variance used?

6. The three data sets have the same mean and range, but is the variation the same? Prove your answer by computing the standard deviation. Assume the data were obtained from samples.
   a. 5, 7, 9, 11, 13, 15, 17
   b. 5, 6, 7, 11, 15, 16, 17
   c. 5, 5, 5, 11, 17, 17

For Exercises 7–13, find the range, variance, and standard deviation. Assume the data represent samples, and use the shortcut formula for the unbiased estimator to compute the variance and standard deviation.

7. **Police Calls in Schools** The number of incidents in which police were needed for a sample of 10 schools in Allegheny County is 7, 37, 3, 8, 48, 11, 6, 0, 10, 3. Are the data consistent or do they vary? Explain your answer.
   Source: U.S. Department of Education.

8. **Cigarette Taxes** The increases (in cents) in cigarette taxes for 17 states in a 6-month period are 60, 20, 40, 40, 45, 12, 34, 51, 30, 70, 42, 31, 69, 32, 8, 18, 50
   Use the range rule of thumb to estimate the standard deviation. Compare the estimate to the actual standard deviation.
   Source: Federation of Tax Administrators.
9. Precipitation and High Temperatures  The normal daily high temperatures (in degrees Fahrenheit) in January for 10 selected cities are as follows.
50, 37, 29, 54, 30, 61, 47, 38, 34, 61
The normal monthly precipitation (in inches) for these same 10 cities is listed here.
4.8, 2.6, 1.5, 1.8, 1.8, 3.3, 5.1, 1.1, 1.8, 2.5
Which set is more variable?

10. Size of U.S. States  The total surface area (in square miles) for each of six selected Eastern states is listed here.
28,995 PA  37,534 FL
31,361 NY  27,087 VA
20,966 ME  37,741 GA
The total surface area for each of six selected Western states is listed (in square miles).
72,964 AZ  70,763 NV
101,510 CA  62,161 OR
66,625 CO  54,339 UT
Which set is more variable?

11. Stories in the Tallest Buildings  The number of stories in the 13 tallest buildings for two different cities is listed below. Which set of data is more variable?
Houston: 75, 71, 64, 56, 53, 47, 55, 52, 50, 50, 50, 47
Pittsburgh: 64, 54, 40, 32, 46, 44, 42, 41, 40, 40, 34, 32, 30

12. Starting Teachers' Salaries  Starting teacher salaries (in equivalent U.S. dollars) for upper secondary education in selected countries are listed below. Which set of data is more variable? (The U.S. average starting salary at this time was $29,641.)

<table>
<thead>
<tr>
<th>Europe</th>
<th>Asia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sweden</td>
<td>$48,704</td>
</tr>
<tr>
<td>Germany</td>
<td>41,441</td>
</tr>
<tr>
<td>Spain</td>
<td>32,679</td>
</tr>
<tr>
<td>Finland</td>
<td>32,136</td>
</tr>
<tr>
<td>Denmark</td>
<td>30,384</td>
</tr>
<tr>
<td>Netherlands</td>
<td>29,326</td>
</tr>
<tr>
<td>Scotland</td>
<td>27,789</td>
</tr>
</tbody>
</table>

13. The average age of U.S. astronaut candidates in the past has been 34, but candidates have ranged in age from 26 to 46. Use the range rule of thumb to estimate the standard deviation of the applicants' ages.
Source: www.nasa.gov

14. Home Runs  Find the range, variance, and standard deviation for the distances of the home runs for McGwire and Sosa, using the data in Exercise 18 in Section 2–1. Compare the ranges and standard deviations. Decide which is more variable or if the variability is about the same. (Use individual data.)

15. Use the data for Exercise 11 in Section 3–1. Find the range, variance, and standard deviation for each set of data. Which set of data is more variable?

16. Deficient Bridges in U.S. States  The Federal Highway Administration reported the number of deficient bridges in each state. Find the range, variance, and standard deviation.

<table>
<thead>
<tr>
<th>State</th>
<th>Deficient Bridges</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>15,458</td>
</tr>
<tr>
<td></td>
<td>1,337</td>
</tr>
<tr>
<td></td>
<td>6,482</td>
</tr>
<tr>
<td></td>
<td>12,470</td>
</tr>
<tr>
<td></td>
<td>23,205</td>
</tr>
<tr>
<td></td>
<td>7,768</td>
</tr>
<tr>
<td></td>
<td>4,131</td>
</tr>
<tr>
<td></td>
<td>810</td>
</tr>
<tr>
<td></td>
<td>10,902</td>
</tr>
<tr>
<td></td>
<td>14,318</td>
</tr>
</tbody>
</table>
Source: USA TODAY.

17. Find the range, variance, and standard deviation for the data in Exercise 17 of Section 2–1.

For Exercises 18 through 27, find the variance and standard deviation.

18. Baseball Team Batting Averages  Team batting averages for major league baseball in 2005 are represented below. Find the variance and standard deviation for each league. Compare the results.

<table>
<thead>
<tr>
<th>League</th>
<th>NL</th>
<th>AL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.252–0.256</td>
<td>0.256–0.261</td>
</tr>
<tr>
<td></td>
<td>0.257–0.261</td>
<td>0.262–0.267</td>
</tr>
<tr>
<td></td>
<td>0.262–0.266</td>
<td>0.268–0.273</td>
</tr>
<tr>
<td></td>
<td>0.267–0.271</td>
<td>0.274–0.279</td>
</tr>
<tr>
<td></td>
<td>0.272–0.276</td>
<td>0.280–0.285</td>
</tr>
</tbody>
</table>

19. Cost per Load of Laundry Detergents  The costs per load (in cents) of 35 laundry detergents tested by a consumer organization are shown here.

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>13–19</td>
<td>2</td>
</tr>
<tr>
<td>20–26</td>
<td>7</td>
</tr>
<tr>
<td>27–33</td>
<td>12</td>
</tr>
<tr>
<td>34–40</td>
<td>5</td>
</tr>
<tr>
<td>41–47</td>
<td>6</td>
</tr>
<tr>
<td>48–54</td>
<td>1</td>
</tr>
<tr>
<td>55–61</td>
<td>0</td>
</tr>
<tr>
<td>62–68</td>
<td>2</td>
</tr>
</tbody>
</table>

138  Chapter 3 Data Description
20. Automotive Fuel Efficiency  Thirty automobiles were tested for fuel efficiency (in miles per gallon). This frequency distribution was obtained.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.5–12.5</td>
<td>3</td>
</tr>
<tr>
<td>12.5–17.5</td>
<td>5</td>
</tr>
<tr>
<td>17.5–22.5</td>
<td>15</td>
</tr>
<tr>
<td>22.5–27.5</td>
<td>5</td>
</tr>
<tr>
<td>27.5–32.5</td>
<td>2</td>
</tr>
</tbody>
</table>

21. Murders in Cities  The data show the number of murders in 25 selected cities.

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>34–96</td>
<td>13</td>
</tr>
<tr>
<td>97–159</td>
<td>2</td>
</tr>
<tr>
<td>160–222</td>
<td>0</td>
</tr>
<tr>
<td>223–285</td>
<td>5</td>
</tr>
<tr>
<td>286–348</td>
<td>1</td>
</tr>
<tr>
<td>349–411</td>
<td>1</td>
</tr>
<tr>
<td>412–474</td>
<td>0</td>
</tr>
<tr>
<td>475–537</td>
<td>1</td>
</tr>
<tr>
<td>538–600</td>
<td>2</td>
</tr>
</tbody>
</table>

22. Reaction Times  In a study of reaction times to a specific stimulus, a psychologist recorded these data (in seconds).

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1–2.7</td>
<td>12</td>
</tr>
<tr>
<td>2.8–3.4</td>
<td>13</td>
</tr>
<tr>
<td>3.5–4.1</td>
<td>7</td>
</tr>
<tr>
<td>4.2–4.8</td>
<td>5</td>
</tr>
<tr>
<td>4.9–5.5</td>
<td>2</td>
</tr>
<tr>
<td>5.6–6.2</td>
<td>1</td>
</tr>
</tbody>
</table>

23. Lightbulb Lifetimes  Eighty randomly selected lightbulbs were tested to determine their lifetimes (in hours). This frequency distribution was obtained.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>52.5–63.5</td>
<td>6</td>
</tr>
<tr>
<td>63.5–74.5</td>
<td>12</td>
</tr>
<tr>
<td>74.5–85.5</td>
<td>25</td>
</tr>
<tr>
<td>85.5–96.5</td>
<td>18</td>
</tr>
<tr>
<td>96.5–107.5</td>
<td>14</td>
</tr>
<tr>
<td>107.5–118.5</td>
<td>5</td>
</tr>
</tbody>
</table>

24. Murder Rates  The data represent the murder rate per 100,000 individuals in a sample of selected cities in the United States.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>5–11</td>
<td>8</td>
</tr>
<tr>
<td>12–18</td>
<td>5</td>
</tr>
<tr>
<td>19–25</td>
<td>7</td>
</tr>
<tr>
<td>26–32</td>
<td>1</td>
</tr>
<tr>
<td>33–39</td>
<td>1</td>
</tr>
<tr>
<td>40–46</td>
<td>3</td>
</tr>
</tbody>
</table>

Source: FBI and U.S. Census Bureau.

25. Battery Lives  Eighty randomly selected batteries were tested to determine their lifetimes (in hours). The following frequency distribution was obtained.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>62.5–73.5</td>
<td>5</td>
</tr>
<tr>
<td>73.5–84.5</td>
<td>14</td>
</tr>
<tr>
<td>84.5–95.5</td>
<td>18</td>
</tr>
<tr>
<td>95.5–106.5</td>
<td>25</td>
</tr>
<tr>
<td>106.5–117.5</td>
<td>12</td>
</tr>
<tr>
<td>117.5–128.5</td>
<td>6</td>
</tr>
</tbody>
</table>

Can it be concluded that the lifetimes of these brands of batteries are consistent?

26. Find the variance and standard deviation for the two distributions in Exercises 8 and 18 in Section 2–2. Compare the variation of the data sets. Decide if one data set is more variable than the other.

27. Word Processor Repairs  This frequency distribution represents the data obtained from a sample of word processor repairers. The values are the days between service calls on 80 machines.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>25.5–28.5</td>
<td>5</td>
</tr>
<tr>
<td>28.5–31.5</td>
<td>9</td>
</tr>
<tr>
<td>31.5–34.5</td>
<td>32</td>
</tr>
<tr>
<td>34.5–37.5</td>
<td>20</td>
</tr>
<tr>
<td>37.5–40.5</td>
<td>12</td>
</tr>
<tr>
<td>40.5–43.5</td>
<td>2</td>
</tr>
</tbody>
</table>

28. Exam Scores  The average score of the students in one calculus class is 110, with a standard deviation of 5; the average score of students in a statistics class is 106, with a standard deviation of 4. Which class is more variable in terms of scores?

29. Suspension Bridges  The lengths (in feet) of the main span of the longest suspension bridges in the United States and the rest of the world are shown below. Which set of data is more variable?

United States: 4205, 4200, 3800, 3500, 3478, 2800, 2800, 2310
World: 6570, 5538, 5328, 4888, 4626, 4544, 4518, 3970


30. Exam Scores  The average score on an English final examination was 85, with a standard deviation of 5; the average score on a history final exam was 110, with a standard deviation of 8. Which class was more variable?

31. Ages of Accountants  The average age of the accountants at Three Rivers Corp. is 26 years, with a standard deviation of 6 years; the average salary of the accountants is $31,000, with a standard deviation of $4000. Compare the variations of age and income.
32. Using Chebyshev’s theorem, solve these problems for a distribution with a mean of 80 and a standard deviation of 10.
   a. At least what percentage of values will fall between 60 and 100?
   b. At least what percentage of values will fall between 65 and 95?
33. The mean of a distribution is 20 and the standard deviation is 2. Use Chebyshev’s theorem.
   a. At least what percentage of the values will fall between 10 and 30?
   b. At least what percentage of the values will fall between 12 and 28?
34. In a distribution of 160 values with a mean of 72, at least 120 fall within the interval 67–77. Approximately what percentage of values should fall in the interval 62–82? Use Chebyshev's theorem.
35. Calories The average number of calories in a regular-size bagel is 240. If the standard deviation is 38 calories, find the range in which at least 75% of the data will lie. Use Chebyshev’s theorem.
36. Time Spent Online Americans spend an average of 3 hours per day online. If the standard deviation is 32 minutes, find the range in which at least 75% of the data will lie. Use Chebyshev’s theorem.
37. Solid Waste Production The average college student produces 640 pounds of solid waste each year including 500 disposable cups and 320 pounds of paper. If the standard deviation is approximately 85 pounds, within what weight limits will at least 88.89% of all students’ garbage lie?
38. Sale Price of Homes The average sale price of new one-family houses in the United States for 2003 was $246,300. Find the range of values in which at least 75% of the sale prices will lie if the standard deviation is $48,500.
39. Trials to Learn a Maze The average of the number of trials it took a sample of mice to learn to traverse a maze was 12. The standard deviation was 3. Using Chebyshev’s theorem, find the minimum percentage of data values that will fall in the range of 4 to 20 trials.
40. Farm Sizes The average farm in the United States in 2004 contained 443 acres. The standard deviation is 42 acres. Use Chebyshev’s theorem to find the minimum percentage of data values that will fall in the range of 338–548 acres.
41. Citrus Fruit Consumption The average U.S. yearly per capita consumption of citrus fruit is 26.8 pounds. Suppose that the distribution of fruit amounts consumed is bell-shaped with a standard deviation equal to 4.2 pounds. What percentage of Americans would you expect to consume more than 31 pounds of citrus fruit per year?
42. Work Hours for College Faculty The average full-time faculty member in a post-secondary degree-granting institution works an average of 53 hours per week.
   a. If we assume the standard deviation is 2.8 hours, what percentage of faculty members work more than 58.6 hours a week?
   b. If we assume a bell-shaped distribution, what percentage of faculty members work more than 58.6 hours a week?
   Source: National Center for Education Statistics.
43. Serum Cholesterol Levels For this data set, find the mean and standard deviation of the variable. The data represent the serum cholesterol levels of 30 individuals. Count the number of data values that fall within 2 standard deviations of the mean. Compare this with the number obtained from Chebyshev’s theorem. Comment on the answer.
44. Ages of Consumers For this data set, find the mean and standard deviation of the variable. The data represent the ages of 30 customers who ordered a product advertised on television. Count the number of data values that fall within 2 standard deviations of the mean. Compare this with the number obtained from Chebyshev’s theorem. Comment on the answer.
45. Using Chebyshev’s theorem, complete the table to find the minimum percentage of data values that fall within \( k \) standard deviations of the mean.

<table>
<thead>
<tr>
<th>( k )</th>
<th>1.5</th>
<th>2</th>
<th>2.5</th>
<th>3</th>
<th>3.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

46. Use this data set: 10, 20, 30, 40, 50
   a. Find the standard deviation.
   b. Add 5 to each value, and then find the standard deviation.
   c. Subtract 5 from each value and find the standard deviation.
   d. Multiply each value by 5 and find the standard deviation.
   e. Divide each value by 5 and find the standard deviation.
   f. Generalize the results of parts b through e.
   g. Compare these results with those in Exercise 38 of Exercises 3–1.

47. The mean deviation is found by using this formula:
   \[
   \text{Mean deviation} = \frac{\sum |X - \bar{X}|}{n}
   \]
   where
   \( X \) = value
   \( \bar{X} \) = mean
   \( n \) = number of values
   \( | \cdot | \) = absolute value

48. A measure to determine the skewness of a distribution is called the Pearson coefficient of skewness. The formula is
   \[
   \text{Skewness} = \frac{3(\bar{X} - MD)}{s}
   \]
   The values of the coefficient usually range from −3 to +3. When the distribution is symmetric, the coefficient is zero; when the distribution is positively skewed, it is positive; and when the distribution is negatively skewed, it is negative.
   Using the formula, find the coefficient of skewness for each distribution, and describe the shape of the distribution.
   a. Mean = 10, median = 8, standard deviation = 3.
   b. Mean = 42, median = 45, standard deviation = 4.
   c. Mean = 18.6, median = 18.6, standard deviation = 1.5.
   d. Mean = 98, median = 97.6, standard deviation = 4.

49. All values of a data set must be within \( \frac{s}{\sqrt{n-1}} \) of the mean. If a person collected 25 data values that had a mean of 50 and a standard deviation of 3 and you saw that one data value was 67, what would you conclude?

---

**Technology Step by Step**

**Excel Step by Step**

**Finding Measures of Variation**

**Example XL3–2**

Find the variance, standard deviation, and range of the data from Example 3–23. The data represent the amount (in millions of dollars) of European auto sales for a sample of 6 years.

| 11.2 | 11.9 | 12.0 | 12.8 | 13.4 | 14.3 |

1. On an Excel worksheet enter the data in cells A2–A7. Enter a label for the variable in cell A1.
2. For the sample variance, enter =VAR(A2:A7).
3. For the sample standard deviation, enter =STDEV(A2:A7).
4. For the range, compute the difference between the maximum and the minimum values by entering =MAX(A2:A7) – MIN(A2:A7).

These and other statistical functions can also be accessed without typing them into the worksheet directly.

1. Select the Formulas tab from the toolbar and select the Insert Function Icon.
2. Select the Statistical category for statistical functions.
3. Scroll to find the appropriate function and click [OK].
Measures of Position

In addition to measures of central tendency and measures of variation, there are measures of position or location. These measures include standard scores, percentiles, deciles, and quartiles. They are used to locate the relative position of a data value in the data set. For example, if a value is located at the 80th percentile, it means that 80% of the values fall below it in the distribution and 20% of the values fall above it. The median is the value that corresponds to the 50th percentile, since one-half of the values fall below it and one-half of the values fall above it. This section discusses these measures of position.

Standard Scores

There is an old saying, “You can’t compare apples and oranges.” But with the use of statistics, it can be done to some extent. Suppose that a student scored 90 on a music test and 45 on an English exam. Direct comparison of raw scores is impossible, since the exams might not be equivalent in terms of number of questions, value of each question, and so on. However, a comparison of a relative standard similar to both can be made. This comparison uses the mean and standard deviation and is called a standard score or z score. (We also use z scores in later chapters.)

A standard score or z score tells how many standard deviations a data value is above or below the mean for a specific distribution of values. If a standard score is zero, then the data value is the same as the mean.

A z score or standard score for a value is obtained by subtracting the mean from the value and dividing the result by the standard deviation. The symbol for a standard score is z. The formula is:

\[ z = \frac{X - \mu}{\sigma} \]

For samples, the formula is

\[ z = \frac{X - \bar{X}}{s} \]

For populations, the formula is

\[ z = \frac{X - \mu}{\sigma} \]

The z score represents the number of standard deviations that a data value falls above or below the mean.

For the purpose of this section, it will be assumed that when we find z scores, the data were obtained from samples.

Example 3–29

Test Scores

A student scored 65 on a calculus test that had a mean of 50 and a standard deviation of 10; she scored 30 on a history test with a mean of 25 and a standard deviation of 5. Compare her relative positions on the two tests.

Solution

First, find the z scores. For calculus the z score is

\[ z = \frac{X - \bar{X}}{s} = \frac{65 - 50}{10} = 1.5 \]
For history the $z$ score is
\[ z = \frac{30 - 25}{5} = 1.0 \]

Since the $z$ score for calculus is larger, her relative position in the calculus class is higher than her relative position in the history class.

Note that if the $z$ score is positive, the score is above the mean. If the $z$ score is 0, the score is the same as the mean. And if the $z$ score is negative, the score is below the mean.

---

**Example 3–30**

**Test Scores**

Find the $z$ score for each test, and state which is higher.

<table>
<thead>
<tr>
<th>Test A</th>
<th>$X = 38$</th>
<th>$\bar{X} = 40$</th>
<th>$s = 5$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test B</td>
<td>$X = 94$</td>
<td>$\bar{X} = 100$</td>
<td>$s = 10$</td>
</tr>
</tbody>
</table>

**Solution**

For test A,
\[ z = \frac{X - \bar{X}}{s} = \frac{38 - 40}{5} = -0.4 \]

For test B,
\[ z = \frac{94 - 100}{10} = -0.6 \]

The score for test A is relatively higher than the score for test B.

*When all data for a variable are transformed into $z$ scores, the resulting distribution will have a mean of 0 and a standard deviation of 1. A $z$ score, then, is actually the number of standard deviations each value is from the mean for a specific distribution. In Example 3–29, the calculus score of 65 was actually 1.5 standard deviations above the mean of 50. This will be explained in greater detail in Chapter 6.*

**Percentiles**

Percentiles are position measures used in educational and health-related fields to indicate the position of an individual in a group.

**Percentiles** divide the data set into 100 equal groups.

In many situations, the graphs and tables showing the percentiles for various measures such as test scores, heights, or weights have already been completed. Table 3–3 shows the percentile ranks for scaled scores on the Test of English as a Foreign Language. If a student had a scaled score of 58 for section 1 (listening and comprehension), that student would have a percentile rank of 81. Hence, that student did better than 81% of the students who took section 1 of the exam.
Figure 3–5 shows percentiles in graphical form of weights of girls from ages 2 to 18. To find the percentile rank of an 11-year-old who weighs 82 pounds, start at the 82-pound weight on the left axis and move horizontally to the right. Find 11 on the horizontal axis and move up vertically. The two lines meet at the 50th percentile curved line; hence, an 11-year-old girl who weighs 82 pounds is in the 50th percentile for her age group. If the lines do not meet exactly on one of the curved percentile lines, then the percentile rank must be approximated.

Percentiles are also used to compare an individual’s test score with the national norm. For example, tests such as the National Educational Development Test (NEDT) are taken by students in ninth or tenth grade. A student’s scores are compared with those of other students locally and nationally by using percentile ranks. A similar test for elementary school students is called the California Achievement Test.

Percentiles are not the same as percentages. That is, if a student gets 72 correct answers out of a possible 100, she obtains a percentage score of 72. There is no indication of her position with respect to the rest of the class. She could have scored the highest, the lowest, or somewhere in between. On the other hand, if a raw score of 72 corresponds to the 64th percentile, then she did better than 64% of the students in her class.

### Table 3–3

<table>
<thead>
<tr>
<th>Scaled score</th>
<th>Section 1: Listening comprehension</th>
<th>Section 2: Structure and written expression</th>
<th>Section 3: Vocabulary and reading comprehension</th>
<th>Total scaled score</th>
<th>Percentile rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>68</td>
<td>99</td>
<td>98</td>
<td></td>
<td>660</td>
<td>99</td>
</tr>
<tr>
<td>66</td>
<td>98</td>
<td>96</td>
<td>98</td>
<td>640</td>
<td>97</td>
</tr>
<tr>
<td>64</td>
<td>96</td>
<td>94</td>
<td>96</td>
<td>620</td>
<td>94</td>
</tr>
<tr>
<td>62</td>
<td>92</td>
<td>90</td>
<td>93</td>
<td>600</td>
<td>89</td>
</tr>
<tr>
<td>60</td>
<td>87</td>
<td>84</td>
<td>88</td>
<td>580</td>
<td>82</td>
</tr>
<tr>
<td>58</td>
<td>81</td>
<td>76</td>
<td>81</td>
<td>560</td>
<td>73</td>
</tr>
<tr>
<td>56</td>
<td>73</td>
<td>68</td>
<td>72</td>
<td>540</td>
<td>62</td>
</tr>
<tr>
<td>54</td>
<td>64</td>
<td>58</td>
<td>61</td>
<td>520</td>
<td>50</td>
</tr>
<tr>
<td>52</td>
<td>54</td>
<td>48</td>
<td>50</td>
<td>500</td>
<td>39</td>
</tr>
<tr>
<td>50</td>
<td>42</td>
<td>38</td>
<td>40</td>
<td>480</td>
<td>29</td>
</tr>
<tr>
<td>48</td>
<td>32</td>
<td>29</td>
<td>30</td>
<td>460</td>
<td>20</td>
</tr>
<tr>
<td>46</td>
<td>22</td>
<td>21</td>
<td>23</td>
<td>440</td>
<td>13</td>
</tr>
<tr>
<td>44</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>420</td>
<td>9</td>
</tr>
<tr>
<td>42</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>400</td>
<td>5</td>
</tr>
<tr>
<td>40</td>
<td>5</td>
<td>7</td>
<td>8</td>
<td>380</td>
<td>3</td>
</tr>
<tr>
<td>38</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>360</td>
<td>1</td>
</tr>
<tr>
<td>36</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>340</td>
<td>1</td>
</tr>
<tr>
<td>34</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>320</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Mean</td>
<td>51.5</td>
<td>52.2</td>
<td>51.4</td>
<td>517</td>
<td>Mean</td>
</tr>
<tr>
<td>S.D.</td>
<td>7.1</td>
<td>7.9</td>
<td>7.5</td>
<td>68</td>
<td>S.D.</td>
</tr>
</tbody>
</table>

*Based on the total group of 1,178,193 examinees tested from July 1989 through June 1991.
Source: Reprinted by permission of Educational Testing Service, the copyright owner.

[Interesting Facts]
The highest recorded temperature on earth was 136°F in Libya in 1922. The lowest recorded temperature on earth was −129°F in Antarctica in 1983.
Figure 3–5
Weights of Girls by Age and Percentile Rankings
Source: Distributed by Mead Johnson Nutritional Division. Reprinted with permission.

Percentiles are symbolized by

\[ P_1, P_2, P_3, \ldots, P_{99} \]

and divide the distribution into 100 groups.

Percentile graphs can be constructed as shown in Example 3–31. Percentile graphs use the same values as the cumulative relative frequency graphs described in Section 2–2, except that the proportions have been converted to percents.
Example 3–31  Systolic Blood Pressure

The frequency distribution for the systolic blood pressure readings (in millimeters of mercury, mm Hg) of 200 randomly selected college students is shown here. Construct a percentile graph.

<table>
<thead>
<tr>
<th>Class boundaries</th>
<th>Frequency</th>
<th>C Cumulative frequency</th>
<th>D Cumulative percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>89.5–104.5</td>
<td>24</td>
<td>24</td>
<td>12</td>
</tr>
<tr>
<td>104.5–119.5</td>
<td>62</td>
<td>86</td>
<td>43</td>
</tr>
<tr>
<td>119.5–134.5</td>
<td>72</td>
<td>158</td>
<td>79</td>
</tr>
<tr>
<td>134.5–149.5</td>
<td>26</td>
<td>184</td>
<td>92</td>
</tr>
<tr>
<td>149.5–164.5</td>
<td>12</td>
<td>196</td>
<td>98</td>
</tr>
<tr>
<td>164.5–179.5</td>
<td>4</td>
<td>200</td>
<td>100</td>
</tr>
</tbody>
</table>

Solution

Step 1  Find the cumulative frequencies and place them in column C.

Step 2  Find the cumulative percentages and place them in column D. To do this step, use the formula

\[ \text{Cumulative } \% = \frac{\text{cumulative frequency}}{n} 
\times 100\% \]

For the first class,

\[ \text{Cumulative } \% = \frac{24}{200} \times 100\% = 12\% \]

The completed table is shown here.

<table>
<thead>
<tr>
<th>A Class boundaries</th>
<th>B Frequency</th>
<th>C Cumulative frequency</th>
<th>D Cumulative percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>89.5–104.5</td>
<td>24</td>
<td>24</td>
<td>12</td>
</tr>
<tr>
<td>104.5–119.5</td>
<td>62</td>
<td>86</td>
<td>43</td>
</tr>
<tr>
<td>119.5–134.5</td>
<td>72</td>
<td>158</td>
<td>79</td>
</tr>
<tr>
<td>134.5–149.5</td>
<td>26</td>
<td>184</td>
<td>92</td>
</tr>
<tr>
<td>149.5–164.5</td>
<td>12</td>
<td>196</td>
<td>98</td>
</tr>
<tr>
<td>164.5–179.5</td>
<td>4</td>
<td>200</td>
<td>100</td>
</tr>
</tbody>
</table>

Step 3  Graph the data, using class boundaries for the x axis and the percentages for the y axis, as shown in Figure 3–6.

Once a percentile graph has been constructed, one can find the approximate corresponding percentile ranks for given blood pressure values and find approximate blood pressure values for given percentile ranks.

For example, to find the percentile rank of a blood pressure reading of 130, find 130 on the x axis of Figure 3–6, and draw a vertical line to the graph. Then move horizontally to the value on the y axis. Note that a blood pressure of 130 corresponds to approximately the 70th percentile.

If the value that corresponds to the 40th percentile is desired, start on the y axis at 40 and draw a horizontal line to the graph. Then draw a vertical line to the x axis and read
the value. In Figure 3–6, the 40th percentile corresponds to a value of approximately 118. Thus, if a person has a blood pressure of 118, he or she is at the 40th percentile.

Finding values and the corresponding percentile ranks by using a graph yields only approximate answers. Several mathematical methods exist for computing percentiles for data. These methods can be used to find the approximate percentile rank of a data value or to find a data value corresponding to a given percentile. When the data set is large (100 or more), these methods yield better results. Examples 3–32 through 3–35 show these methods.

**Percentile Formula**

The percentile corresponding to a given value $X$ is computed by using the following formula:

$$
\text{Percentile} = \frac{(\text{number of values below } X) + 0.5}{\text{total number of values}} \times 100\%
$$

**Example 3–32 Test Scores**

A teacher gives a 20-point test to 10 students. The scores are shown here. Find the percentile rank of a score of 12.

18, 15, 12, 6, 8, 2, 3, 5, 20, 10

**Solution**

Arrange the data in order from lowest to highest.

2, 3, 5, 6, 8, 10, 12, 15, 18, 20

Then substitute into the formula.

$$
\text{Percentile} = \frac{(\text{number of values below } X) + 0.5}{\text{total number of values}} \times 100\%
$$

Since there are six values below a score of 12, the solution is

$$
\text{Percentile} = \frac{6 + 0.5}{10} \times 100\% = 65\text{th percentile}
$$

Thus, a student whose score was 12 did better than 65% of the class.
Example 3–33 Test Scores
Using the data in Example 3–32, find the percentile rank for a score of 6.

Solution
There are three values below 6. Thus
\[
\text{Percentile} = \frac{3 + 0.5}{10} \cdot 100\% = 35\text{th percentile}
\]
A student who scored 6 did better than 35% of the class.

Examples 3–34 and 3–35 show a procedure for finding a value corresponding to a given percentile.

Example 3–34 Test Scores
Using the scores in Example 3–32, find the value corresponding to the 25th percentile.

Solution
Step 1 Arrange the data in order from lowest to highest.
2, 3, 5, 6, 8, 10, 12, 15, 18, 20

Step 2 Compute
\[
c = \frac{n \cdot p}{100}
\]
where
\[n = \text{total number of values}\]
\[p = \text{percentile}\]
Thus,
\[
c = \frac{10 \cdot 25}{100} = 2.5
\]
Step 3 If \(c\) is not a whole number, round it up to the next whole number; in this case, \(c = 3\). (If \(c\) is a whole number, see Example 3–35.) Start at the lowest value and count over to the third value, which is 5. Hence, the value 5 corresponds to the 25th percentile.

Example 3–35 Using the data set in Example 3–32, find the value that corresponds to the 60th percentile.

Solution
Step 1 Arrange the data in order from smallest to largest.
2, 3, 5, 6, 8, 10, 12, 15, 18, 20

Note: One assumes that a score of 12 in Example 3–32, for instance, means theoretically any value between 11.5 and 12.5.
Step 2  Substitute in the formula.
\[
c = \frac{n \cdot p}{100} = \frac{10 \cdot 60}{100} = 6
\]

Step 3  If \( c \) is a whole number, use the value halfway between the \( c \) and \( c + 1 \) values when counting up from the lowest value—in this case, the 6th and 7th values.

2, 3, 5, 6, 8, 10, 12, 15, 18, 20

- 6th value
- 7th value

The value halfway between 10 and 12 is 11. Find it by adding the two values and dividing by 2.

\[
\frac{10 + 12}{2} = 11
\]

Hence, 11 corresponds to the 60th percentile. Anyone scoring 11 would have done better than 60% of the class.

The steps for finding a value corresponding to a given percentile are summarized in this Procedure Table.

---

### Procedure Table

**Finding a Data Value Corresponding to a Given Percentile**

**Step 1**  Arrange the data in order from lowest to highest.

**Step 2**  Substitute into the formula

\[
c = \frac{n \cdot p}{100}
\]

where

- \( n \) = total number of values
- \( p \) = percentile

**Step 3A**  If \( c \) is not a whole number, round up to the next whole number. Starting at the lowest value, count over to the number that corresponds to the rounded-up value.

**Step 3B**  If \( c \) is a whole number, use the value halfway between the \( c \)th and \((c + 1)\)st values when counting up from the lowest value.

---

### Quartiles and Deciles

**Quartiles** divide the distribution into four groups, separated by \( Q_1, Q_2, Q_3 \).

Note that \( Q_1 \) is the same as the 25th percentile; \( Q_2 \) is the same as the 50th percentile, or the median; \( Q_3 \) corresponds to the 75th percentile, as shown:

- Smallest data value
- \( Q_1 \)
- Median (MD)
- \( Q_3 \)
- Largest data value

\[
\begin{align*}
\text{25\%} & & 25\% & & 25\% & & 25\% \\
Q_1 & & \text{MD} & & Q_3 \\
\end{align*}
\]
Quartiles can be computed by using the formula given for computing percentiles on page 148. For $Q_1$ use $p = 25$. For $Q_2$ use $p = 50$. For $Q_3$ use $p = 75$. However, an easier method for finding quartiles is found in this Procedure Table.

### Procedure Table

**Finding Data Values Corresponding to $Q_1$, $Q_2$, and $Q_3$**

**Step 1** Arrange the data in order from lowest to highest.

**Step 2** Find the median of the data values. This is the value for $Q_2$.

**Step 3** Find the median of the data values that fall below $Q_2$. This is the value for $Q_1$.

**Step 4** Find the median of the data values that fall above $Q_2$. This is the value for $Q_3$.

Example 3–36 shows how to find the values of $Q_1$, $Q_2$, and $Q_3$.

### Example 3–36

Find $Q_1$, $Q_2$, and $Q_3$ for the data set 15, 13, 6, 5, 12, 50, 22, 18.

**Solution**

**Step 1** Arrange the data in order.

5, 6, 12, 13, 15, 18, 22, 50

**Step 2** Find the median ($Q_2$).

5, 6, 12, 13, 15, 18, 22, 50

\[ MD = \frac{13 + 15}{2} = 14 \]

**Step 3** Find the median of the data values less than 14.

5, 6, 12, 13

\[ Q_1 = \frac{6 + 12}{2} = 9 \]

So $Q_1$ is 9.

**Step 4** Find the median of the data values greater than 14.

15, 18, 22, 50

\[ Q_3 = \frac{18 + 22}{2} = 20 \]

Here $Q_3$ is 20. Hence, $Q_1 = 9$, $Q_2 = 14$, and $Q_3 = 20$. 
In addition to dividing the data set into four groups, quartiles can be used as a rough measurement of variability. The interquartile range (IQR) is defined as the difference between $Q_1$ and $Q_3$ and is the range of the middle 50% of the data.

The interquartile range is used to identify outliers, and it is also used as a measure of variability in exploratory data analysis, as shown in Section 3–4.

Deciles divide the distribution into 10 groups, as shown. They are denoted by $D_1$, $D_2$, etc.

Note that $D_1$ corresponds to $P_{10}$; $D_2$ corresponds to $P_{20}$; etc. Deciles can be found by using the formulas given for percentiles. Taken altogether then, these are the relationships among percentiles, deciles, and quartiles.

Deciles are denoted by $D_1$, $D_2$, $D_3$, . . . , $D_9$, and they correspond to $P_{10}$, $P_{20}$, $P_{30}$, . . . , $P_{90}$.

Quartiles are denoted by $Q_1$, $Q_2$, $Q_3$ and they correspond to $P_{25}$, $P_{50}$, $P_{75}$.

The median is the same as $P_{50}$ or $Q_2$ or $D_5$.

The position measures are summarized in Table 3–4.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Definition</th>
<th>Symbol(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard score</td>
<td>Number of standard deviations that a data value is above or below the mean</td>
<td>$z$</td>
</tr>
<tr>
<td>or $z$ score</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percentile</td>
<td>Position in hundredths that a data value holds in the distribution</td>
<td>$P_n$</td>
</tr>
<tr>
<td>Decile</td>
<td>Position in tenths that a data value holds in the distribution</td>
<td>$D_n$</td>
</tr>
<tr>
<td>Quartile</td>
<td>Position in fourths that a data value holds in the distribution</td>
<td>$Q_n$</td>
</tr>
</tbody>
</table>

Outliers

A data set should be checked for extremely high or extremely low values. These values are called outliers.

An outlier is an extremely high or an extremely low data value when compared with the rest of the data values.

An outlier can strongly affect the mean and standard deviation of a variable. For example, suppose a researcher mistakenly recorded an extremely high data value. This value would then make the mean and standard deviation of the variable much larger than they really were. Outliers can have an effect on other statistics as well.

There are several ways to check a data set for outliers. One method is shown in this Procedure Table.
**Chapter 3  Data Description**

**Procedure Table**

**Procedure for Identifying Outliers**

**Step 1**  
Arrange the data in order and find $Q_1$ and $Q_3$.

**Step 2**  
Find the interquartile range: $IQR = Q_3 - Q_1$.

**Step 3**  
Multiply the IQR by 1.5.

**Step 4**  
Subtract the value obtained in step 3 from $Q_1$ and add the value to $Q_3$.

**Step 5**  
Check the data set for any data value that is smaller than $Q_1 - 1.5(IQR)$ or larger than $Q_3 + 1.5(IQR)$.

This procedure is shown in Example 3–37.

**Example 3–37**  
Check the following data set for outliers.

5, 6, 12, 13, 15, 18, 22, 50

**Solution**

The data value 50 is extremely suspect. These are the steps in checking for an outlier.

**Step 1**  
Find $Q_1$ and $Q_3$. This was done in Example 3–36; $Q_1$ is 9 and $Q_3$ is 20.

**Step 2**  
Find the interquartile range (IQR), which is $Q_3 - Q_1$.

$IQR = Q_3 - Q_1 = 20 - 9 = 11$

**Step 3**  
Multiply this value by 1.5.

$1.5(11) = 16.5$

**Step 4**  
Subtract the value obtained in step 3 from $Q_1$, and add the value obtained in step 3 to $Q_3$.

$9 - 16.5 = -7.5$ and $20 + 16.5 = 36.5$

**Step 5**  
Check the data set for any data values that fall outside the interval from $-7.5$ to $36.5$. The value 50 is outside this interval; hence, it can be considered an outlier.

There are several reasons why outliers may occur. First, the data value may have resulted from a measurement or observational error. Perhaps the researcher measured the variable incorrectly. Second, the data value may have resulted from a recording error. That is, it may have been written or typed incorrectly. Third, the data value may have been obtained from a subject that is not in the defined population. For example, suppose test scores were obtained from a seventh-grade class, but a student in that class was actually in the sixth grade and had special permission to attend the class. This student might have scored extremely low on that particular exam on that day. Fourth, the data value might be a legitimate value that occurred by chance (although the probability is extremely small).
There are no hard-and-fast rules on what to do with outliers, nor is there complete agreement among statisticians on ways to identify them. Obviously, if they occurred as a result of an error, an attempt should be made to correct the error or else the data value should be omitted entirely. When they occur naturally by chance, the statistician must make a decision about whether to include them in the data set.

When a distribution is normal or bell-shaped, data values that are beyond 3 standard deviations of the mean can be considered suspected outliers.

**Applying the Concepts 3–3**

**Determining Dosages**

In an attempt to determine necessary dosages of a new drug (HDL) used to control sepsis, assume you administer varying amounts of HDL to 40 mice. You create four groups and label them *low dosage, moderate dosage, large dosage,* and *very large dosage.* The dosages also vary within each group. After the mice are injected with the HDL and the sepsis bacteria, the time until the onset of sepsis is recorded. Your job as a statistician is to effectively communicate the results of the study.

1. Which measures of position could be used to help describe the data results?
2. If 40% of the mice in the top quartile survived after the injection, how many mice would that be?
3. What information can be given from using percentiles?
4. What information can be given from using quartiles?
5. What information can be given from using standard scores?

See page 180 for the answers.

**Exercises 3–3**

1. What is a \(z\) score?
2. Define percentile rank.
3. What is the difference between a percentage and a percentile?
4. Define quartile.
5. What is the relationship between quartiles and percentiles?
6. What is a decile?
7. How are deciles related to percentiles?
8. To which percentile, quartile, and decile does the median correspond?
9. Vacation Days If the average number of vacation days for a selection of various countries has a mean of 29.4 days and a standard deviation of 8.6, find the \(z\) scores for the average number of vacation days in each of these countries.

<table>
<thead>
<tr>
<th>Country</th>
<th>Average Days</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>26 days</td>
</tr>
<tr>
<td>Italy</td>
<td>42 days</td>
</tr>
<tr>
<td>United States</td>
<td>13 days</td>
</tr>
</tbody>
</table>

*Source: www.infoplease.com*

10. Age of Senators The average age of senators in the 108th Congress was 59.5 years. If the standard deviation was 11.5 years, find the \(z\) scores corresponding to the oldest and youngest senators: Robert C. Byrd (D, WV), 86, and John Sununu (R, NH), 40.

*Source: CRS Report for Congress.*

11. Exam Scores A final examination for a psychology course has a mean of 84 and a standard deviation of 4. Find the corresponding \(z\) score for each raw score.

| a. 87 | b. 79 | c. 93 | d. 76 | e. 82 |

12. Teacher’s Salary The average teacher’s salary in a particular state is $54,166. If the standard deviation is
$10,200, find the salaries corresponding to the following z scores.

a. 2  

b. –1  

c. 0  

d. 2.5  

e. –1.6  

13. Which has a better relative position: a score of 75 on a statistics test with a mean of 60 and a standard deviation of 10 or a score of 36 on an accounting test with a mean of 30 and a variance of 16?

14. Test Scores A student scores 60 on a mathematics test that has a mean of 54 and a standard deviation of 3, and she scores 80 on a history test with a mean of 75 and a standard deviation of 2. On which test did she perform better?

15. Which score indicates the highest relative position?

a. A score of 3.2 on a test with $\mu = 4.6$ and $\sigma = 1.5$

b. A score of 630 on a test with $\mu = 800$ and $\sigma = 200$

c. A score of 43 on a test with $\mu = 50$ and $\sigma = 5$

d. A score of 25 on a test with $\mu = 100$ and $\sigma = 10$

e. A score of 10 on a test with $\mu = 100$ and $\sigma = 100$

16. College Room and Board Costs Room and board costs for selected schools are summarized in this distribution. Find the approximate cost of room and board corresponding to each of the following percentiles.

<table>
<thead>
<tr>
<th>Costs (in dollars)</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000.5–4000.5</td>
<td>5</td>
</tr>
<tr>
<td>4000.5–5000.5</td>
<td>6</td>
</tr>
<tr>
<td>5000.5–6000.5</td>
<td>18</td>
</tr>
<tr>
<td>6000.5–7000.5</td>
<td>24</td>
</tr>
<tr>
<td>7000.5–8000.5</td>
<td>19</td>
</tr>
<tr>
<td>8000.5–9000.5</td>
<td>8</td>
</tr>
<tr>
<td>9000.5–10,000.5</td>
<td>5</td>
</tr>
</tbody>
</table>

a. 30th percentile  

b. 50th percentile  

c. 75th percentile  

d. 90th percentile  


17. Using the data in Exercise 16, find the approximate percentile rank of each of the following costs.

a. 5500  

b. 7200  

c. 6500  

d. 8300  

e. 9000

18. Achievement Test Scores (ans) The data shown represent the scores on a national achievement test for a group of 10th-grade students. Find the approximate percentile ranks of these scores by constructing a percentile graph.

<table>
<thead>
<tr>
<th>Score</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>196.5–217.5</td>
<td>5</td>
</tr>
<tr>
<td>217.5–238.5</td>
<td>17</td>
</tr>
<tr>
<td>238.5–259.5</td>
<td>22</td>
</tr>
<tr>
<td>259.5–280.5</td>
<td>48</td>
</tr>
<tr>
<td>280.5–301.5</td>
<td>22</td>
</tr>
<tr>
<td>301.5–322.5</td>
<td>6</td>
</tr>
</tbody>
</table>

19. For the data in Exercise 18, find the approximate scores that correspond to these percentiles.

a. 15th  

b. 29th  

c. 43rd  

d. 65th  

e. 80th

20. Airplane Speeds (ans) The airborne speeds in miles per hour of 21 planes are shown. Find the approximate values that correspond to the given percentiles by constructing a percentile graph.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>366–386</td>
<td>4</td>
</tr>
<tr>
<td>387–407</td>
<td>2</td>
</tr>
<tr>
<td>408–428</td>
<td>3</td>
</tr>
<tr>
<td>429–449</td>
<td>2</td>
</tr>
<tr>
<td>450–470</td>
<td>1</td>
</tr>
<tr>
<td>471–491</td>
<td>2</td>
</tr>
<tr>
<td>492–512</td>
<td>3</td>
</tr>
<tr>
<td>513–533</td>
<td>4</td>
</tr>
</tbody>
</table>


21. Using the data in Exercise 20, find the approximate percentile ranks of the following miles per hour (mph).

a. 380 mph  

b. 425 mph  

c. 455 mph  

d. 505 mph  

e. 525 mph

22. Average Weekly Earnings The average weekly earnings in dollars for various industries are listed below. Find the percentile rank of each value.

| 804 | 736 | 659 | 489 | 777 | 623 | 597 | 524 | 228 |


23. For the data from Exercise 22, what value corresponds to the 40th percentile?
24. Test Scores  Find the percentile rank for each test score in the data set.
   12, 28, 35, 42, 47, 49, 50

25. In Exercise 24, what value corresponds to the 60th percentile?

26. Hurricane Damage  Find the percentile rank for each value in the data set. The data represent the values in billions of dollars of the damage of 10 hurricanes.
   1.1, 1.7, 1.9, 2.1, 2.2, 2.5, 3.3, 6.2, 6.8, 20.3
   Source: Insurance Services Office.

27. What value in Exercise 26 corresponds to the 40th percentile?

28. Test Scores  Find the percentile rank for each test score in the data set.
   5, 12, 15, 16, 20, 21

29. What test score in Exercise 28 corresponds to the 33rd percentile?

30. Using the procedure shown in Example 3–37, check each data set for outliers.
   a. 16, 18, 22, 19, 3, 21, 17, 20
   b. 24, 32, 54, 31, 16, 18, 19, 14, 17, 20
   c. 321, 343, 350, 327, 200
   d. 88, 72, 97, 84, 86, 85, 100
   e. 145, 119, 122, 118, 125, 116
   f. 14, 16, 27, 18, 13, 19, 36, 15, 20

31. Another measure of average is called the midquartile; it is the numerical value halfway between \( Q_1 \) and \( Q_3 \), and the formula is
   \[
   \text{Midquartile} = \frac{Q_1 + Q_3}{2}
   \]
   Using this formula and other formulas, find \( Q_1 \), \( Q_2 \), \( Q_3 \), the midquartile, and the interquartile range for each data set.
   a. 5, 12, 16, 25, 32, 38
   b. 53, 62, 78, 94, 96, 99, 103

### Technology Step by Step

**Minitab Step by Step**

**Calculate Descriptive Statistics from Data**

**Example MT3–1**

1. Enter the data from Example 3–23 into C1 of Minitab. Name the column AutoSales.
3. The cursor will be blinking in the Variables text box. Double-click C1 AutoSales.
4. Click [Statistics] to view the statistics that can be calculated with this command.
   a) Check the boxes for Mean, Standard deviation, Variance, Coefficient of variation, Median, Minimum, Maximum, and N nonmissing.
   b) Remove the checks from other options.
5. Click [OK] twice. The results will be displayed in the session window as shown.

**Descriptive Statistics: AutoSales**

<table>
<thead>
<tr>
<th>Variable</th>
<th>N</th>
<th>Mean</th>
<th>Median</th>
<th>StDev</th>
<th>Variance</th>
<th>CoefVar</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoSales</td>
<td>6</td>
<td>12.6</td>
<td>12.4</td>
<td>1.129</td>
<td>1.276</td>
<td>8.965</td>
<td>11.2</td>
<td>14.3</td>
</tr>
</tbody>
</table>

Session window results are in text format. A high-resolution graphical window displays the descriptive statistics, a histogram, and a boxplot.

6. Select **Stat>Basic Statistics>Graphical Summary.**
7. Double-click C1 AutoSales.
8. Click [OK].

The graphical summary will be displayed in a separate window as shown.

**Calculate Descriptive Statistics from a Frequency Distribution**

Multiple menu selections must be used to calculate the statistics from a table. We will use data given in Example 3–24.

**Enter Midpoints and Frequencies**

1. Select **File>New>New Worksheet** to open an empty worksheet.
2. To enter the midpoints into C1, select **Calc>Make Patterned Data>Simple Set of Numbers.**
   a) Type X to name the column.
   b) Type in 8 for the First value, 38 for the Last value, and 5 for Steps.
   c) Click [OK].
3. Enter the frequencies in C2. Name the column f.

**Calculate Columns for f·X and f·X²**

4. Select **Calc>Calculator.**
   a) Type in fX for the variable and f*X in the Expression dialog box. Click [OK].
   b) Select **Edit>Edit Last Dialog** and type in fX2 for the variable and f*X**2** for the expression.
   c) Click [OK]. There are now four columns in the worksheet.
Calculate the Column Sums

5. Select Calc>Column Statistics.
   This command stores results in constants, not columns.
   Click [OK] after each step.
   a) Click the option for Sum; then select C2 f for the Input column, and type n for Store result in.
   b) Select Edit>Edit Last Dialog; then select C3 fX for the column and type sumX for storage.
   c) Edit the last dialog box again. This time select C4 fX2 for the column, then type sumX2 for storage.

To verify the results, navigate to the Project Manager window, then the constants folder of the worksheet. The sums are 20, 490, and 13,310.

Calculate the Mean, Variance, and Standard Deviation

   a) Type Mean for the variable, then click in the box for the Expression and type sumX/n. Click [OK]. If you double-click the constants instead of typing them, single quotes will surround the names. The quotes are not required unless the column name has spaces.
   b) Click the EditLast Dialog icon and type Variance for the variable.
   c) In the expression box type in (sumX2-sumX**2/n)/(n-1)
   d) Edit the last dialog box and type S for the variable. In the expression box, drag the mouse over the previous expression to highlight it.
   e) Click the button in the keypad for parentheses. Type SQRT at the beginning of the line, upper- or lowercase will work. The expression should be SQRT((sumX2-sumX**2/n)/(n-1)).
   f) Click [OK].

Display Results

   g) Select Data>Display Data, then highlight all columns and constants in the list.
   h) Click [Select] then [OK].

The session window will display all our work! Create the histogram with instructions from Chapter 2.
Calculating Descriptive Statistics

To calculate various descriptive statistics:
1. Enter data into L1.
2. Press STAT to get the menu.
3. Press \( \text{2nd} [\text{L1}] \) then ENTER.

The calculator will display:
- \( \bar{x} \): sample mean
- \( \Sigma x \): sum of the data values
- \( \Sigma x^2 \): sum of the squares of the data values
- \( s \): sample standard deviation
- \( \sigma \): population standard deviation
- \( n \): number of data values
- \( \min X \): smallest data value
- \( Q_1 \): lower quartile
- \( Med \): median
- \( Q_3 \): upper quartile
- \( \max X \): largest data value

Example TI3–1

Find the various descriptive statistics for the auto sales data from Example 3–23:

11.2, 11.9, 12.0, 12.8, 13.4, 14.3
Following the steps just shown, we obtain these results, as shown on the screen:

- The mean is 12.6.
- The sum of $x$ is 75.6.
- The sum of $x^2$ is 958.94.
- The sample standard deviation $S_x$ is 1.1296017.
- The population standard deviation $\sigma_x$ is 1.031180553.
- The sample size $n$ is 6.
- The smallest data value is 11.2.
- $Q_1$ is 11.9.
- The median is 12.4.
- $Q_3$ is 13.4.
- The largest data value is 14.3.

To calculate the mean and standard deviation from grouped data:

1. Enter the midpoints into $L_1$.
2. Enter the frequencies into $L_2$.
3. Press STAT to get the menu.
4. Use the arrow keys to move the cursor to CALC; then press 1 for 1-Var Stats.
5. Press 2nd $[L1]$, 2nd $[L2]$, then ENTER.

**Example TI3–2**

Calculate the mean and standard deviation for the data given in Examples 3–3 and 3–24.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
<th>Midpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5–10.5</td>
<td>1</td>
<td>8</td>
</tr>
<tr>
<td>10.5–15.5</td>
<td>2</td>
<td>13</td>
</tr>
<tr>
<td>15.5–20.5</td>
<td>3</td>
<td>18</td>
</tr>
<tr>
<td>20.5–25.5</td>
<td>5</td>
<td>23</td>
</tr>
<tr>
<td>25.5–30.5</td>
<td>4</td>
<td>28</td>
</tr>
<tr>
<td>30.5–35.5</td>
<td>3</td>
<td>33</td>
</tr>
<tr>
<td>35.5–40.5</td>
<td>2</td>
<td>38</td>
</tr>
</tbody>
</table>

The sample mean is 24.5, and the sample standard deviation is 8.287593772.

To graph a percentile graph, follow the procedure for an ogive but use the cumulative percent in $L_2$, 100 for $Y_{max}$, and the data from Example 3–31.
Measures of Position

Example XL3–3

Find the z scores for each value of the data from Example 3–23. The data represent the amount (in millions of dollars) of European auto sales for a sample of 6 years.

11.2 11.9 12.0 12.8 13.4 14.3

1. On an Excel worksheet enter the data in cells A2–A7. Enter a label for the variable in cell A1.
2. Label cell B1 as z score.
4. Select the Formulas tab from the toolbar and Insert Function .
5. Select the Statistical category for statistical functions and scroll in the function list to STANDARDIZE and click [OK].

In the STANDARDIZE dialog box:
6. Type A2 for the X value.
7. Type average(A2:A7) for the Mean.
8. Type stdev(A2:A7) for the Standard_dev. Then click [OK].
9. Repeat the procedure above for each data value in column A.

Example XL3–4

Find the percentile rank for each value of the data from Example 3–23. The data represent the amount (in millions of dollars) of European auto sales for a sample of 6 years.

11.2 11.9 12.0 12.8 13.4 14.3

1. On an Excel worksheet enter the data in cells A2–A7. Enter a label for the variable in cell A1.
2. Label cell B1 as z score.
4. Select the Formulas tab from the toolbar and Insert Function .
5. Select the Statistical category for statistical functions and scroll in the function list to PERCENTRANK and click [OK].

In the PERCENTRANK dialog box:
6. Type A2:A7 for the Array.
7. Type A2 for the X value, then click [OK].
8. Repeat the procedure above for each data value in column A.

The PERCENTRANK function returns the percentile rank as a decimal. To convert this to a percentage, multiply the function output by 100. Make sure to select a new column before multiplying the percentile rank by 100.

**Descriptive Statistics in Excel**

**Example XL3–5**

Excel Analysis Tool-Pak Add-in Data Analysis includes an item called Descriptive Statistics that reports many useful measures for a set of data.

1. Enter the data set shown in cells A1 to A9 of a new worksheet.

   12  17  15  16  16  14  18  13  10

   See the Excel Step by Step in Chapter 1 for the instructions on loading the Analysis Tool-Pak Add-in.

2. Select the Data tab on the toolbar and select Data Analysis.
3. In the Analysis Tools dialog box, scroll to Descriptive Statistics, then click [OK].
4. Type A1:A9 in the Input Range box and check the Grouped by Columns option.
5. Select the Output Range option and type in cell C1.
6. Check the Summary statistics option and click [OK].
Chapter 3 Data Description

3–4 Exploratory Data Analysis

In traditional statistics, data are organized by using a frequency distribution. From this distribution various graphs such as the histogram, frequency polygon, and ogive can be constructed to determine the shape or nature of the distribution. In addition, various statistics such as the mean and standard deviation can be computed to summarize the data. The purpose of traditional analysis is to confirm various conjectures about the nature of the data. For example, from a carefully designed study, a researcher might want to know if the proportion of Americans who are exercising today has increased from 10 years ago. This study would contain various assumptions about the population, various definitions such as of exercise, and so on.

In exploratory data analysis (EDA), data can be organized using a stem and leaf plot. (See Chapter 2.) The measure of central tendency used in EDA is the median. The measure of variation used in EDA is the interquartile range $Q_3 - Q_1$. In EDA the data are represented graphically using a boxplot (sometimes called a box-and-whisker plot). The purpose of exploratory data analysis is to examine data to find out what information can be discovered about the data such as the center and the spread. Exploratory data analysis was developed by John Tukey and presented in his book Exploratory Data Analysis (Addison-Wesley, 1977).

The Five-Number Summary and Boxplots

A boxplot can be used to graphically represent the data set. These plots involve five specific values:

1. The lowest value of the data set (i.e., minimum)
2. $Q_1$
3. The median
4. $Q_3$
5. The highest value of the data set (i.e., maximum)

These values are called a five-number summary of the data set.

A boxplot is a graph of a data set obtained by drawing a horizontal line from the minimum data value to $Q_1$, drawing a horizontal line from $Q_3$ to the maximum data value, and drawing a box whose vertical sides pass through $Q_1$ and $Q_3$ with a vertical line inside the box passing through the median or $Q_2$. 

Below is the summary output for this data set.

<table>
<thead>
<tr>
<th>Column1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
</tr>
<tr>
<td>Standard Error</td>
</tr>
<tr>
<td>Median</td>
</tr>
<tr>
<td>Mode</td>
</tr>
<tr>
<td>Standard Deviation</td>
</tr>
<tr>
<td>Sample Variance</td>
</tr>
<tr>
<td>Kurtosis</td>
</tr>
<tr>
<td>Skewness</td>
</tr>
<tr>
<td>Range</td>
</tr>
<tr>
<td>Minimum</td>
</tr>
<tr>
<td>Maximum</td>
</tr>
<tr>
<td>Sum</td>
</tr>
<tr>
<td>Count</td>
</tr>
</tbody>
</table>
Procedure for constructing a boxplot

1. Find the five-number summary for the data values, that is, the maximum and minimum data values, $Q_1$ and $Q_3$, and the median.
2. Draw a horizontal axis with a scale such that it includes the maximum and minimum data values.
3. Draw a box whose vertical sides go through $Q_1$ and $Q_3$, and draw a vertical line though the median.
4. Draw a line from the minimum data value to the left side of the box and a line from the maximum data value to the right side of the box.

Example 3–38
Number of Meteorites Found

The number of meteorites found in 10 states of the United States is 89, 47, 164, 296, 30, 215, 138, 78, 48, 39. Construct a boxplot for the data.

Source: Natural History Museum.

Solution

Step 1  Arrange the data in order:

30, 39, 47, 48, 78, 89, 138, 164, 215, 296

Step 2  Find the median.

$\text{Median} = \frac{78 + 89}{2} = 83.5$

Step 3  Find $Q_1$.

30, 39, 47, 48, 78

\[\text{(up)}\]

$Q_1$

Step 4  Find $Q_3$.

89, 138, 164, 215, 296

\[\text{(up)}\]

$Q_3$

Step 5  Draw a scale for the data on the $x$ axis.

Step 6  Located the lowest value, $Q_1$, median, $Q_3$, and the highest value on the scale.

Step 7  Draw a box around $Q_1$ and $Q_3$, draw a vertical line through the median, and connect the upper value and the lower value to the box. See Figure 3–7.

The distribution is somewhat positively skewed.
Example 3–39  Sodium Content of Cheese

A dietitian is interested in comparing the sodium content of real cheese with the sodium content of a cheese substitute. The data for two random samples are shown. Compare the distributions, using boxplots.

<table>
<thead>
<tr>
<th>Real cheese</th>
<th>Cheese substitute</th>
</tr>
</thead>
<tbody>
<tr>
<td>310 420 45 40</td>
<td>270 180 250 290</td>
</tr>
<tr>
<td>220 240 180 90</td>
<td>130 260 340 310</td>
</tr>
</tbody>
</table>

Source: The Complete Book of Food Counts.

Solution

Step 1  Find $Q_1$, MD, and $Q_3$ for the real cheese data.

\[
\begin{align*}
Q_1 &= \frac{45 + 90}{2} = 67.5 \\
MD &= \frac{180 + 220}{2} = 200 \\
Q_3 &= \frac{240 + 310}{2} = 275
\end{align*}
\]

Step 2  Find $Q_1$, MD, and $Q_3$ for the cheese substitute data.

\[
\begin{align*}
Q_1 &= \frac{180 + 250}{2} = 215 \\
MD &= \frac{260 + 270}{2} = 265 \\
Q_3 &= \frac{290 + 310}{2} = 300
\end{align*}
\]

Step 3  Draw the boxplots for each distribution on the same graph. See Figure 3–8.
Step 4  Compare the plots. It is quite apparent that the distribution for the cheese substitute data has a higher median than the median for the distribution for the real cheese data. The variation or spread for the distribution of the real cheese data is larger than the variation for the distribution of the cheese substitute data.

A modified boxplot can be drawn and used to check for outliers. See Exercise 18 in Extending the Concepts in this section.

In exploratory data analysis, hinges are used instead of quartiles to construct boxplots. When the data set consists of an even number of values, hinges are the same as quartiles. Hinges for a data set with an odd number of values differ somewhat from quartiles. However, since most calculators and computer programs use quartiles, they will be used in this textbook.

Another important point to remember is that the summary statistics (median and interquartile range) used in exploratory data analysis are said to be resistant statistics. A resistant statistic is relatively less affected by outliers than a nonresistant statistic. The mean and standard deviation are nonresistant statistics. Sometimes when a distribution is skewed or contains outliers, the median and interquartile range may more accurately summarize the data than the mean and standard deviation, since the mean and standard deviation are more affected in this case.

Table 3–5 shows the correspondence between the traditional and the exploratory data analysis approach.

<table>
<thead>
<tr>
<th>Traditional</th>
<th>Exploratory data analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency distribution</td>
<td>Stem and leaf plot</td>
</tr>
<tr>
<td>Histogram</td>
<td>Boxplot</td>
</tr>
<tr>
<td>Mean</td>
<td>Median</td>
</tr>
<tr>
<td>Standard deviation</td>
<td>Interquartile range</td>
</tr>
</tbody>
</table>
Applying the Concepts 3–4

The Noisy Workplace
Assume you work for OSHA (Occupational Safety and Health Administration) and have complaints about noise levels from some of the workers at a state power plant. You charge the power plant with taking decibel readings at six different areas of the plant at different times of the day and week. The results of the data collection are listed. Use boxplots to initially explore the data and make recommendations about which plant areas workers must be provided with protective ear wear. The safe hearing level is at approximately 120 decibels.

<table>
<thead>
<tr>
<th>Area 1</th>
<th>Area 2</th>
<th>Area 3</th>
<th>Area 4</th>
<th>Area 5</th>
<th>Area 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>64</td>
<td>100</td>
<td>25</td>
<td>59</td>
<td>67</td>
</tr>
<tr>
<td>12</td>
<td>99</td>
<td>59</td>
<td>15</td>
<td>63</td>
<td>80</td>
</tr>
<tr>
<td>35</td>
<td>87</td>
<td>78</td>
<td>30</td>
<td>81</td>
<td>99</td>
</tr>
<tr>
<td>65</td>
<td>97</td>
<td>97</td>
<td>20</td>
<td>110</td>
<td>49</td>
</tr>
<tr>
<td>24</td>
<td>23</td>
<td>84</td>
<td>61</td>
<td>65</td>
<td>67</td>
</tr>
<tr>
<td>59</td>
<td>16</td>
<td>64</td>
<td>56</td>
<td>112</td>
<td>56</td>
</tr>
<tr>
<td>68</td>
<td>94</td>
<td>53</td>
<td>34</td>
<td>132</td>
<td>80</td>
</tr>
<tr>
<td>57</td>
<td>78</td>
<td>59</td>
<td>22</td>
<td>145</td>
<td>125</td>
</tr>
<tr>
<td>100</td>
<td>57</td>
<td>89</td>
<td>24</td>
<td>163</td>
<td>100</td>
</tr>
<tr>
<td>61</td>
<td>32</td>
<td>88</td>
<td>21</td>
<td>120</td>
<td>93</td>
</tr>
<tr>
<td>32</td>
<td>52</td>
<td>94</td>
<td>32</td>
<td>84</td>
<td>56</td>
</tr>
<tr>
<td>45</td>
<td>78</td>
<td>66</td>
<td>52</td>
<td>99</td>
<td>45</td>
</tr>
<tr>
<td>92</td>
<td>59</td>
<td>57</td>
<td>14</td>
<td>105</td>
<td>80</td>
</tr>
<tr>
<td>56</td>
<td>55</td>
<td>62</td>
<td>10</td>
<td>68</td>
<td>34</td>
</tr>
<tr>
<td>44</td>
<td>55</td>
<td>64</td>
<td>33</td>
<td>75</td>
<td>21</td>
</tr>
</tbody>
</table>

See page 180 for the answers.

Exercises 3–4

For Exercises 1–6, identify the five-number summary and find the interquartile range.

1. 8, 12, 32, 6, 27, 19, 54
2. 19, 16, 48, 22, 7
3. 362, 589, 437, 316, 192, 188
4. 147, 243, 156, 632, 543, 303
5. 14.6, 19.8, 16.3, 15.5, 18.2
6. 9.7, 4.6, 2.2, 3.7, 6.2, 9.4, 3.8

For Exercises 7–10, use each boxplot to identify the maximum value, minimum value, median, first quartile, third quartile, and interquartile range.
8. Construct a boxplot for the following data and comment on the shape of the distribution representing the number of games pitched by major league baseball's earned run average (ERA) leaders for the past few years.

30 34 29 30 34 29 31 33 34 27
30 27 34 32

Source: *World Almanac*.

9. Construct a boxplot for the following data which represents the number of innings pitched by the ERA leaders for the past few years. Comment on the shape of the distribution.

192 228 186 199 238 217 213 234 264 187
214 115 238 246

Source: *World Almanac*.

10. Construct a boxplot for these numbers of state sites for Frogwatch USA. Is the distribution symmetric?

421 395 314 294 289 253 242 238 235 199

Source: www.nwf.org/frogwatch

11. **Earned Run Average—Number of Games Pitched**  Construct a boxplot for the following data and comment on the shape of the distribution representing the number of games pitched by major league baseball’s earned run average (ERA) leaders for the past few years.

30 34 29 30 34 29 31 33 34 27
30 27 34 32

Source: *World Almanac*.

12. **Innings Pitched**  Construct a boxplot for the following data which represents the number of innings pitched by the ERA leaders for the past few years. Comment on the shape of the distribution.

192 228 186 199 238 217 213 234 264 187
214 115 238 246

Source: *World Almanac*.

13. **State Sites for Frogwatch**  Construct a boxplot for these numbers of state sites for Frogwatch USA. Is the distribution symmetric?

421 395 314 294 289 253 242 238 235 199

Source: www.nwf.org/frogwatch

14. **Median Household Incomes**  Construct a boxplot and comment on the skewness of these data which represent median household income (in dollars) for the top 10 educated cities (based on the percent of the population with a college degree or higher).

49,297 48,131 43,731 39,752 55,637
57,496 47,221 41,829 42,562 42,442

Source: www.encarta.msn.com

15. **Tornadoes in 2005**  Construct a boxplot and comment on its skewness for the number of tornadoes recorded each month in 2005.

33 10 62 123 316 138 123 133 18
150 26

Source: Storm Prediction Center.

16. **Size of Dams**  These data represent the volumes in cubic yards of the largest dams in the United States and in South America. Construct a boxplot of the data for each region and compare the distributions.

<table>
<thead>
<tr>
<th>United States</th>
<th>South America</th>
</tr>
</thead>
<tbody>
<tr>
<td>125,628</td>
<td>311,539</td>
</tr>
<tr>
<td>92,000</td>
<td>274,026</td>
</tr>
<tr>
<td>78,008</td>
<td>105,944</td>
</tr>
<tr>
<td>77,700</td>
<td>102,014</td>
</tr>
<tr>
<td>66,500</td>
<td>56,242</td>
</tr>
<tr>
<td>62,850</td>
<td>46,563</td>
</tr>
<tr>
<td>52,435</td>
<td></td>
</tr>
<tr>
<td>50,000</td>
<td></td>
</tr>
</tbody>
</table>

Source: *New York Times Almanac*. 

3–65
17. **Number of Tornadoes**  A four-month record for the number of tornadoes in 2003–2005 is given here.

```
<table>
<thead>
<tr>
<th>Month</th>
<th>2005</th>
<th>2004</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>April</td>
<td>132</td>
<td>125</td>
<td>157</td>
</tr>
<tr>
<td>May</td>
<td>123</td>
<td>509</td>
<td>543</td>
</tr>
<tr>
<td>June</td>
<td>316</td>
<td>268</td>
<td>292</td>
</tr>
<tr>
<td>July</td>
<td>138</td>
<td>124</td>
<td>167</td>
</tr>
</tbody>
</table>
```

a. Which month had the highest mean number of tornadoes for this 3-year period?
b. Which year has the highest mean number of tornadoes for this 4-month period?
c. Construct three boxplots and compare the distributions.

Source: NWS, Storm Prediction Center.

---

**Extending the Concepts**

18. **Unhealthful Smog Days**  A modified boxplot can be drawn by placing a box around $Q_1$ and $Q_3$ and then extending the whiskers to the largest and/or smallest values within 1.5 times the interquartile range

(i.e., $Q_3 - Q_1$). **Mild outliers** are values between 1.5(IQR) and 3(IQR). **Extreme outliers** are data values beyond 3(IQR).

For the data shown here, draw a modified boxplot and identify any mild or extreme outliers. The data represent the number of unhealthful smog days for a specific year for the highest 10 locations.

```
97   39   43   66   91
43   54   42   53   39
```

Source: U.S. Public Interest Research Group and Clean Air Network.

---

**Technology Step by Step**

**MINITAB Step by Step**

**Construct a Boxplot**

1. Type in the data 33, 38, 43, 30, 29, 51, 27, 42, 23, 31. Label the column **Clients**.
2. Select **Stat > EDA > Boxplot**.
3. Double-click **Clients** to select it for the Y variable.
4. Click on [Labels].
   a) In the Title 1: of the Title/Footnotes folder, type **Number of Clients**.
   b) Press the [Tab] key and type **Your Name** in the text box for Subtitle 1:
5. Click [OK] twice. The graph will be displayed in a graph window.

Example MT3–2

1. Enter the data for Example 2–13 in Section 2–3. Label the column CARS-THEFT.
2. Select Stat > EDA > Boxplot.
3. Double-click CARS-THEFT to select it for the Y variable.
4. Click on the drop-down arrow for Annotation.
5. Click on Title, then enter an appropriate title such as Car Thefts for Large City, U.S.A.
6. Click [OK] twice.

A high-resolution graph will be displayed in a graph window.

**Boxplot Dialog Box and Boxplot**

**TI-83 Plus or TI-84 Plus**

**Step by Step**

**Constructing a Boxplot**

To draw a boxplot:

1. Enter data into L1.
2. Change values in WINDOW menu, if necessary. *(Note: Make Xmin somewhat smaller than the smallest data value and Xmax somewhat larger than the largest data value.) Change Ymin to 0 and Ymax to 1.*
3. Press [2nd] [STAT PLOT], then 1 for Plot 1.
4. Press ENTER to turn Plot 1 on.
5. Move cursor to Boxplot symbol (fifth graph) on the Type: line, then press ENTER.
Chapter 3 Data Description

Excel Step by Step

Constructing a Stem and Leaf Plot and a Boxplot

Example XL3–6

Excel does not have procedures to produce stem and leaf plots or boxplots. However, you may construct these plots by using the MegaStat Add-in available on your CD or from the Online Learning Center. If you have not installed this add-in, refer to the instructions in the Excel Step by Step section of Chapter 1.

To obtain a boxplot and stem and leaf plot:

1. Enter the data values 33, 38, 43, 30, 29, 40, 51, 27, 42, 23, 31 into column A of a new Excel worksheet.
2. Select the Add-Ins tab, then MegaStat from the toolbar.

4. Enter the cell range A1:A11 in the Input range.

5. Check both Boxplot and Stem and Leaf Plot. Note: You may leave the other output options unchecked for this example. Click [OK].

The stem and leaf plot and the boxplot are shown below.

**Summary**

This chapter explains the basic ways to summarize data. These include measures of central tendency, measures of variation or dispersion, and measures of position. The three most commonly used measures of central tendency are the mean, median, and mode. The midrange is also used occasionally to represent an average. The three most commonly used measurements of variation are the range, variance, and standard deviation.

The most common measures of position are percentiles, quartiles, and deciles. This chapter explains how data values are distributed according to Chebyshev’s theorem and the empirical rule. The coefficient of variation is used to describe the standard deviation in relationship to the mean. These methods are commonly called traditional statistical methods and are primarily used to confirm various conjectures about the nature of the data.

Other methods, such as the boxplot and five-number summaries, are part of exploratory data analysis; they are used to examine data to see what they reveal.

After learning the techniques presented in Chapter 2 and this chapter, you will have a substantial knowledge of descriptive statistics. That is, you will be able to collect, organize, summarize, and present data.
Important Terms

bimodal 111
boxplot 162
Chebyshev’s theorem 134
coefficient of variation 132
data array 109
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151

interquartile range (IQR) 151
parameter 106
symmetric
distribution 117
unimodal 111

important term

bimodal 111
boxplot 162
Chebyshev’s theorem 134
coefficient of variation 132
data array 109
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151
decile 151

interquartile range (IQR) 151
parameter 106
symmetric
distribution 117
unimodal 111

Important Formulas

Formula for the mean for individual data:

\[
\bar{X} = \frac{\sum X}{n} \quad \mu = \frac{\sum X}{N}
\]

Formula for the range:

\[
R = \text{highest value} - \text{lowest value}
\]

Formula for the midrange:

\[
MR = \frac{\text{lowest value} + \text{highest value}}{2}
\]

Formula for the weighted mean:

\[
\bar{X} = \frac{\sum wX}{\sum w}
\]

Formula for the variance for population data:

\[
\sigma^2 = \frac{\sum(X - \mu)^2}{N}
\]

Formula for the variance for sample data (shortcut formula for the unbiased estimator):

\[
s^2 = \frac{n(\sum X^2) - (\sum X)^2}{n(n - 1)}
\]

Formula for the variance for grouped data:

\[
s^2 = \frac{n(\sum f \cdot X^2) - (\sum f \cdot X_m)^2}{n(n - 1)}
\]

Formula for the standard deviation for population data:

\[
\sigma = \sqrt{\frac{\sum(X - \mu)^2}{N}}
\]

Formula for the standard deviation for sample data (shortcut formula):

\[
s = \sqrt{\frac{n(\sum X^2) - (\sum X)^2}{n(n - 1)}}
\]

Formula for the standard deviation for grouped data:

\[
s = \sqrt{\frac{n(\sum f \cdot X^2) - (\sum f \cdot X_m)^2}{n(n - 1)}}
\]

Formula for the coefficient of variation:

\[
CVar = \frac{s}{\bar{X}} \cdot 100\% \quad \text{or} \quad CVar = \frac{\sigma}{\mu} \cdot 100\%
\]

Range rule of thumb:

\[
s \approx \frac{\text{range}}{4}
\]

Expression for Chebyshev’s theorem: The proportion of values from a data set that will fall within \(k\) standard deviations of the mean will be at least

\[
1 - \frac{1}{k^2}
\]

where \(k\) is a number greater than 1.

Formula for the z score (standard score):

\[
z = \frac{X - \mu}{\sigma} \quad \text{or} \quad z = \frac{X - \bar{X}}{s}
\]
Formula for the cumulative percentage:
\[
\text{Cumulative } \% = \frac{\text{cumulative frequency}}{n} \cdot 100\%
\]

Formula for the percentile rank of a value \(X\):
\[
\text{Percentile} = \frac{\text{number of values below } X + 0.5}{\text{total number of values}} \cdot 100\%
\]

Review Exercises

1. **Hospitals** The following set of data represents the number of hospitals for selected states. Find the mean, median, mode, midrange, range, variance, and standard deviation for the data.

<table>
<thead>
<tr>
<th>Number of Hospitals</th>
</tr>
</thead>
<tbody>
<tr>
<td>53</td>
</tr>
<tr>
<td>84</td>
</tr>
<tr>
<td>28</td>
</tr>
<tr>
<td>78</td>
</tr>
<tr>
<td>35</td>
</tr>
<tr>
<td>111</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>166</td>
</tr>
<tr>
<td>108</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>123</td>
</tr>
<tr>
<td>87</td>
</tr>
<tr>
<td>84</td>
</tr>
<tr>
<td>74</td>
</tr>
<tr>
<td>80</td>
</tr>
<tr>
<td>62</td>
</tr>
</tbody>
</table>


2. **Elementary and Secondary Schools** These data represent the number of both elementary and secondary schools for selected states.

<table>
<thead>
<tr>
<th>Elementary</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>938</td>
<td>403</td>
</tr>
<tr>
<td>711</td>
<td>423</td>
</tr>
<tr>
<td>824</td>
<td>240</td>
</tr>
<tr>
<td>139</td>
<td>43</td>
</tr>
<tr>
<td>977</td>
<td>432</td>
</tr>
<tr>
<td>194</td>
<td>333</td>
</tr>
<tr>
<td>518</td>
<td>223</td>
</tr>
<tr>
<td>1196</td>
<td>285</td>
</tr>
<tr>
<td>497</td>
<td></td>
</tr>
<tr>
<td>137</td>
<td></td>
</tr>
<tr>
<td>575</td>
<td></td>
</tr>
<tr>
<td>475</td>
<td></td>
</tr>
<tr>
<td>849</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
</tr>
<tr>
<td>156</td>
<td></td>
</tr>
<tr>
<td>401</td>
<td></td>
</tr>
<tr>
<td>362</td>
<td></td>
</tr>
<tr>
<td>327</td>
<td></td>
</tr>
<tr>
<td>205</td>
<td></td>
</tr>
<tr>
<td>223</td>
<td></td>
</tr>
<tr>
<td>285</td>
<td></td>
</tr>
</tbody>
</table>

For each set of data find:

a. Mean          e. Range
b. Median        f. Variance
c. Mode          g. Standard deviation
d. Midrange

Which set of data is more variable?


3. **Battery Lives** Twelve batteries were tested to see how many hours they would last. The frequency distribution is shown here.

<table>
<thead>
<tr>
<th>Hours</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–3</td>
<td>1</td>
</tr>
<tr>
<td>4–6</td>
<td>4</td>
</tr>
<tr>
<td>7–9</td>
<td>5</td>
</tr>
<tr>
<td>10–12</td>
<td>1</td>
</tr>
<tr>
<td>13–15</td>
<td>1</td>
</tr>
</tbody>
</table>

Find each of these.

a. Mean          c. Variance
b. Modal class   d. Standard deviation

4. **SAT Scores** The mean SAT math scores for selected states are represented below. Find the mean class, modal class, variance, and standard deviation, and comment on the shape of the data.

<table>
<thead>
<tr>
<th>Score</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>478–504</td>
<td>4</td>
</tr>
<tr>
<td>505–531</td>
<td>6</td>
</tr>
<tr>
<td>532–558</td>
<td>2</td>
</tr>
<tr>
<td>559–585</td>
<td>2</td>
</tr>
<tr>
<td>586–612</td>
<td>2</td>
</tr>
</tbody>
</table>


5. **Rise in Tides** Shown here is a frequency distribution for the rise in tides at 30 selected locations in the United States.

<table>
<thead>
<tr>
<th>Rise in tides (inches)</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.5–27.5</td>
<td>6</td>
</tr>
<tr>
<td>27.5–42.5</td>
<td>3</td>
</tr>
<tr>
<td>42.5–57.5</td>
<td>5</td>
</tr>
<tr>
<td>57.5–72.5</td>
<td>8</td>
</tr>
<tr>
<td>72.5–87.5</td>
<td>6</td>
</tr>
<tr>
<td>87.5–102.5</td>
<td>2</td>
</tr>
</tbody>
</table>

Find each of these.

a. Mean          c. Variance
b. Modal class   d. Standard deviation

6. **Fuel Capacity** The fuel capacity in gallons of 50 randomly selected 1995 cars is shown here.

<table>
<thead>
<tr>
<th>Class</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>10–12</td>
<td>6</td>
</tr>
<tr>
<td>13–15</td>
<td>4</td>
</tr>
<tr>
<td>16–18</td>
<td>14</td>
</tr>
<tr>
<td>19–21</td>
<td>15</td>
</tr>
<tr>
<td>22–24</td>
<td>8</td>
</tr>
<tr>
<td>25–27</td>
<td>2</td>
</tr>
<tr>
<td>28–30</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>30</td>
</tr>
</tbody>
</table>
Find each of these.

- Mean
- Modal class
- Variance
- Standard deviation

7. Number of Cavities In a dental survey of third-grade students, this distribution was obtained for the number of cavities found. Find the average number of cavities for the class. Use the weighted mean.

<table>
<thead>
<tr>
<th>Number of students</th>
<th>Number of cavities</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
</tr>
</tbody>
</table>

8. Investment Earnings An investor calculated these percentages of each of three stock investments with payoffs as shown. Find the average payoff. Use the weighted mean.

<table>
<thead>
<tr>
<th>Stock</th>
<th>Percent</th>
<th>Payoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>30</td>
<td>$10,000</td>
</tr>
<tr>
<td>B</td>
<td>50</td>
<td>3,000</td>
</tr>
<tr>
<td>C</td>
<td>20</td>
<td>1,000</td>
</tr>
</tbody>
</table>

9. Years of Service of Employees In an advertisement, a transmission service center stated that the average years of service of its employees were 13. The distribution is shown here. Using the weighted mean, calculate the correct average.

<table>
<thead>
<tr>
<th>Number of employees</th>
<th>Years of service</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>1</td>
<td>30</td>
</tr>
</tbody>
</table>

10. Textbooks in Professors’ Offices If the average number of textbooks in professors’ offices is 16, the standard deviation is 5, and the average age of the professors is 43, with a standard deviation of 8, which data set is more variable?

11. Magazines in Bookstores A survey of bookstores showed that the average number of magazines carried is 56, with a standard deviation of 12. The same survey showed that the average length of time each store had been in business was 6 years, with a standard deviation of 2.5 years. Which is more variable, the number of magazines or the number of years?

12. Years of Service of Supreme Court Members The number of years served by selected past members of the U.S. Supreme Court is listed below. Find the percentile rank for each value. Which value corresponds to the 40th percentile? Construct a boxplot for the data and comment on their shape.

19, 15, 16, 24, 17, 4, 3, 31, 23, 5, 33

13. NFL Salaries The salaries (in millions of dollars) for 29 NFL teams for the 1999–2000 season are given in this frequency distribution.

<table>
<thead>
<tr>
<th>Class limits</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>39.9–42.8</td>
<td>2</td>
</tr>
<tr>
<td>42.9–45.8</td>
<td>2</td>
</tr>
<tr>
<td>45.9–48.8</td>
<td>5</td>
</tr>
<tr>
<td>48.9–51.8</td>
<td>5</td>
</tr>
<tr>
<td>51.9–54.8</td>
<td>12</td>
</tr>
<tr>
<td>54.9–57.8</td>
<td>3</td>
</tr>
</tbody>
</table>

Source: www.NFL.com

- Construct a percentile graph.
- Find the values that correspond to the 35th, 65th, and 85th percentiles.
- Find the percentile of values 44, 48, and 54.

14. Check each data set for outliers.

- a. 506, 511, 517, 514, 400, 521
- b. 3, 7, 9, 6, 8, 10, 14, 16, 20, 12
- c. 14, 18, 27, 26, 19, 13, 5, 25
- d. 112, 157, 192, 116, 153, 129, 131

15. Cost of Car Rentals A survey of car rental agencies shows that the average cost of a car rental is $0.32 per mile. The standard deviation is $0.03. Using Chebyshev’s theorem, find the range in which at least 75% of the data values will fall.

16. Average Earnings of Workers The average earnings of year-round full-time workers 25–34 years old with a bachelor’s degree or higher were $58,500 in 2003. If the standard deviation is $11,200, what can you say about the percentage of these workers who earn

- a. Between $47,300 and $69,700?
- b. More than $80,900?
- c. How likely is it that someone earns more than $100,000?


17. Labor Charges The average labor charge for automobile mechanics is $54 per hour. The standard deviation is $4. Find the minimum percentage of data values that will fall within the range of $48 to $60. Use Chebyshev’s theorem.

18. Costs to Train Employees For a certain type of job, it costs a company an average of $231 to train an employee to perform the task. The standard deviation is $5. Find the minimum percentage of data values that will fall in the range of $219 to $243. Use Chebyshev’s theorem.

19. Delivery Charges The average delivery charge for a refrigerator is $32. The standard deviation is $4. Find the minimum percentage of data values that will fall in the range of $20 to $44. Use Chebyshev’s theorem.
20. **Exam Grades** Which of these exam grades has a better relative position?

- A grade of 82 on a test with $\bar{X} = 85$ and $s = 6$
- A grade of 56 on a test with $\bar{X} = 60$ and $s = 5$

21. **Top Movie Sites** The number of sites at which the top nine movies (based on the daily gross earnings) opened in a particular week is indicated below.

<table>
<thead>
<tr>
<th>Number of Sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>3017</td>
</tr>
<tr>
<td>2516</td>
</tr>
<tr>
<td>3211</td>
</tr>
<tr>
<td>3687</td>
</tr>
<tr>
<td>2525</td>
</tr>
<tr>
<td>2820</td>
</tr>
<tr>
<td>3044</td>
</tr>
<tr>
<td>2525</td>
</tr>
<tr>
<td>3211</td>
</tr>
</tbody>
</table>

Construct a boxplot for the data.

The 10th movie on the list opened at only 909 theaters. Add this number to the above set of data and construct a boxplot. Comment on the changes that occur.

Source: www.showbizdata.com

---

22. **Hours Worked** The data shown here represent the number of hours that 12 part-time employees at a toy store worked during the weeks before and after Christmas.

<table>
<thead>
<tr>
<th>Number of Hours Before and After Christmas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before: 38 16 18 24 12 30 35 32 31 30 24 35</td>
</tr>
<tr>
<td>After: 26 15 12 18 24 32 14 18 16 18 22 12</td>
</tr>
</tbody>
</table>

Construct two boxplots and compare the distributions.

23. **Commuter Times** The mean of the times it takes a commuter to get to work in Baltimore is 29.7 minutes. If the standard deviation is 6 minutes, within what limits would you expect approximately 68% of the times to fall? Assume the distribution is approximately bell-shaped.

---

**Statistics Today**

**How Long Are You Delayed by Road Congestion?—Revisited**

The average number of hours per year that a driver is delayed by road congestion is listed here.

<table>
<thead>
<tr>
<th>City</th>
<th>Delay (hours/year)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Los Angeles</td>
<td>56</td>
</tr>
<tr>
<td>Atlanta</td>
<td>53</td>
</tr>
<tr>
<td>Seattle</td>
<td>53</td>
</tr>
<tr>
<td>Houston</td>
<td>50</td>
</tr>
<tr>
<td>Dallas</td>
<td>46</td>
</tr>
<tr>
<td>Washington</td>
<td>46</td>
</tr>
<tr>
<td>Austin</td>
<td>45</td>
</tr>
<tr>
<td>Denver</td>
<td>45</td>
</tr>
<tr>
<td>St. Louis</td>
<td>44</td>
</tr>
<tr>
<td>Orlando</td>
<td>42</td>
</tr>
<tr>
<td>U.S. average</td>
<td>36</td>
</tr>
</tbody>
</table>

Source: Texas Transportation Institute.

By making comparisons using averages, you can see that drivers in these 10 cities are delayed by road congestion more than the national average.
Chapter Quiz

Determine whether each statement is true or false. If the statement is false, explain why.

1. When the mean is computed for individual data, all values in the data set are used.
2. The mean cannot be found for grouped data when there is an open class.
3. A single, extremely large value can affect the median more than the mean.
4. One-half of all the data values will fall above the mode, and one-half will fall below the mode.
5. In a data set, the mode will always be unique.
6. The range and midrange are both measures of variation.
7. One disadvantage of the median is that it is not unique.
8. The mode and midrange are both measures of variation.
9. If a person’s score on an exam corresponds to the 75th percentile, then that person obtained 75 correct answers out of 100 questions.

Select the best answer.

10. What is the value of the mode when all values in the data set are different?
   a. 0 
   b. 1 
   c. There is no mode.
   d. It cannot be determined unless the data values are given.

11. When data are categorized as, for example, places of residence (rural, suburban, urban), the most appropriate measure of central tendency is the
   a. Mean 
   b. Median 
   c. Mode 

12. \( P_{50} \) corresponds to
   a. \( Q_2 \)
   b. \( D_5 \)
   c. IQR
   d. Midrange

13. Which is not part of the five-number summary?
   a. \( Q_1 \) and \( Q_3 \)
   b. The mean
   c. The median
   d. The smallest and the largest data values

14. A statistic that tells the number of standard deviations a data value is above or below the mean is called
   a. A quartile
   b. A percentile

   c. A coefficient of variation
   d. A \( z \) score

15. When a distribution is bell-shaped, approximately what percentage of data values will fall within 1 standard deviation of the mean?
   a. 50%
   b. 68%
   c. 95%
   d. 99.7%

Complete these statements with the best answer.

16. A measure obtained from sample data is called \( \text{a(n)} \) ______.

17. Generally, Greek letters are used to represent ______, and Roman letters are used to represent ______.

18. The positive square root of the variance is called the ______.

19. The symbol for the population standard deviation is ______.

20. When the sum of the lowest data value and the highest data value is divided by 2, the measure is called ______.

21. If the mode is to the left of the median and the mean is to the right of the median, then the distribution is ______ skewed.

22. An extremely high or extremely low data value is called a(n) ______.

23. Miles per Gallon  The number of highway miles per gallon of the 10 worst vehicles is shown.

<table>
<thead>
<tr>
<th>Miles per Gallon</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
</tr>
<tr>
<td>18</td>
<td>1</td>
</tr>
</tbody>
</table>

Source: Pittsburgh Post Gazette.

Find each of these.
   a. Mean
   b. Median
   c. Mode
   d. Midrange
   e. Range
   f. Variance
   g. Standard deviation

24. Errors on a Typing Test  The distribution of the number of errors that 10 students made on a typing test is shown.

<table>
<thead>
<tr>
<th>Errors</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–2</td>
<td>1</td>
</tr>
<tr>
<td>3–5</td>
<td>3</td>
</tr>
<tr>
<td>6–8</td>
<td>4</td>
</tr>
<tr>
<td>9–11</td>
<td>1</td>
</tr>
<tr>
<td>12–14</td>
<td>1</td>
</tr>
</tbody>
</table>
25. **Inches of Rain** Showed here is a frequency distribution for the number of inches of rain received in 1 year in 25 selected cities in the United States.

<table>
<thead>
<tr>
<th>Number of inches</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5–20.5</td>
<td>2</td>
</tr>
<tr>
<td>20.5–35.5</td>
<td>3</td>
</tr>
<tr>
<td>35.5–50.5</td>
<td>8</td>
</tr>
<tr>
<td>50.5–65.5</td>
<td>6</td>
</tr>
<tr>
<td>65.5–80.5</td>
<td>3</td>
</tr>
<tr>
<td>80.5–95.5</td>
<td>3</td>
</tr>
</tbody>
</table>

Find each of these.

a. Mean  

b. Modal class  

c. Variance  

d. Standard deviation

26. **Shipment Times** A survey of 36 selected recording companies showed these numbers of days that it took to receive a shipment from the day it was ordered.

<table>
<thead>
<tr>
<th>Days</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1–3</td>
<td>6</td>
</tr>
<tr>
<td>4–6</td>
<td>8</td>
</tr>
<tr>
<td>7–9</td>
<td>10</td>
</tr>
<tr>
<td>10–12</td>
<td>7</td>
</tr>
<tr>
<td>13–15</td>
<td>0</td>
</tr>
<tr>
<td>16–18</td>
<td>5</td>
</tr>
</tbody>
</table>

Find each of these.

a. Mean  

b. Modal class  

c. Variance  

d. Standard deviation

27. **Best Friends of Students** In a survey of third-grade students, this distribution was obtained for the number of “best friends” each had.

<table>
<thead>
<tr>
<th>Number of students</th>
<th>Number of best friends</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
</tr>
</tbody>
</table>

Find the average number of best friends for the class. Use the weighted mean.

28. **Employee Years of Service** In an advertisement, a retail store stated that its employees averaged 9 years of service. The distribution is shown here.

<table>
<thead>
<tr>
<th>Number of employees</th>
<th>Years of service</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
</tr>
</tbody>
</table>

Using the weighted mean, calculate the correct average.

29. **Newspapers for Sale** The average number of newspapers for sale in an airport newsstand is 12, and the standard deviation is 4. The average age of the pilots is 37 years, with a standard deviation of 6 years. Which data set is more variable?

30. **Brands of Toothpaste Carried** A survey of grocery stores showed that the average number of brands of toothpaste carried was 16, with a standard deviation of 5. The same survey showed the average length of time each store was in business was 7 years, with a standard deviation of 1.6 years. Which is more variable, the number of brands or the number of years?

31. **Test Scores** A student scored 76 on a general science test where the class mean and standard deviation were 82 and 8, respectively; he also scored 53 on a psychology test where the class mean and standard deviation were 58 and 3, respectively. In which class was his relative position higher?

32. Which score has the highest relative position?

   a. \( X = 12 \quad \bar{X} = 10 \quad s = 4 \)
   
   b. \( X = 170 \quad \bar{X} = 120 \quad s = 32 \)
   
   c. \( X = 180 \quad \bar{X} = 60 \quad s = 8 \)

33. **Sizes of Malls** The number of square feet (in millions) of eight of the largest malls in southwestern Pennsylvania is shown.

<table>
<thead>
<tr>
<th>Source: International Council of Shopping Centers.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>1.4</td>
</tr>
</tbody>
</table>

Find the percentile for each value.

b. What value corresponds to the 40th percentile?

c. Construct a boxplot and comment on the nature of the distribution.

34. **Exam Scores** On a philosophy comprehensive exam, this distribution was obtained from 25 students.

<table>
<thead>
<tr>
<th>Score</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>40.5–45.5</td>
<td>3</td>
</tr>
<tr>
<td>45.5–50.5</td>
<td>8</td>
</tr>
<tr>
<td>50.5–55.5</td>
<td>10</td>
</tr>
<tr>
<td>55.5–60.5</td>
<td>3</td>
</tr>
<tr>
<td>60.5–65.5</td>
<td>1</td>
</tr>
</tbody>
</table>

a. Construct a percentile graph.

b. Find the values that correspond to the 22nd, 78th, and 99th percentiles.

c. Find the percentiles of the values 52, 43, and 64.

35. **Gas Prices for Rental Cars** The first column of these data represents the prebuy gas price of a rental car, and the second column represents the price charged if the car is returned without refilling the gas tank for a selected car rental company. Draw two boxplots for the data and compare the distributions. (Note: The data were collected several years ago.)
36. **SAT Scores** The average national SAT score is 1019. If we assume a bell-shaped distribution and a standard deviation equal to 110, what percentage of scores will you expect to fall above 1129? Above 799?

(Source: *New York Times Almanac*, 2002.)

---

### Critical Thinking Challenges

1. **Average Cost of Weddings** Averages give us information to help us to see where we stand and enable us to make comparisons. Here is a study on the average cost of a wedding. What type of average—mean, median, mode, or midrange—might have been used for each category?

<table>
<thead>
<tr>
<th>Prebuy cost</th>
<th>No prebuy cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>$1.55</td>
<td>$3.80</td>
</tr>
<tr>
<td>1.54</td>
<td>3.99</td>
</tr>
<tr>
<td>1.62</td>
<td>3.99</td>
</tr>
<tr>
<td>1.65</td>
<td>3.85</td>
</tr>
<tr>
<td>1.72</td>
<td>3.99</td>
</tr>
<tr>
<td>1.63</td>
<td>3.95</td>
</tr>
<tr>
<td>1.65</td>
<td>3.94</td>
</tr>
<tr>
<td>1.72</td>
<td>4.19</td>
</tr>
<tr>
<td>1.45</td>
<td>3.84</td>
</tr>
<tr>
<td>1.52</td>
<td>3.94</td>
</tr>
</tbody>
</table>

(Source: *USA Today*.)

---

### OTHER PEOPLE’S MONEY

*Question:* What is the hottest wedding month? *Answer:* It’s a tie. September now ranks as high as June in U.S. nuptials.

The average attendance is 186 guests.

And what kind of tabs are people running up for these affairs? Well, the next time a bride is throwing a bouquet, single women might want to... duck!

- Reception: $7246
- Rings: $4042
- Photos/Videography: $1263
- Bridal gown: $790
- Flowers: $775
- Music: $745
- Invitations: $374
- Mother of the bride’s dress: $198
- Other (veil, limo, fees, etc.): $3441

*Average cost of a wedding: $18,874*

*(Stats: Bride’s 2000 State of the Union Report)*

(source: Reprinted with permission from the September 2001 Reader’s Digest. Copyright © 2001 by The Reader’s Digest Assn., Inc.)

2. **Average Cost of Smoking** This article states that the average yearly cost of smoking a pack of cigarettes a day is $1190. Find the average cost of a pack of cigarettes in your area, and compute the cost per day for 1 year. Compare your answer with the one in the article.
Burning Through the Cash

Everyone knows the health-related reasons to quit smoking, so here's an economic argument: A pack a day adds up to $1190 a year on average; it's more in states that have higher taxes on tobacco. To calculate what you or a loved one spends, visit ashline.org/ASH/quit/contemplation/index.html and try out their smoker's calculator. You'll be stunned.

Source: Reprinted with permission from the April 2002 Reader's Digest. Copyright © 2002 by The Reader's Digest Assn., Inc.

3. Ages of U.S. Residents  The table shows the median ages of residents for the 10 oldest states and the 10 youngest states of the United States including Washington, D.C. Explain why the median is used instead of the mean.

<table>
<thead>
<tr>
<th>Rank</th>
<th>State</th>
<th>Median age</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>West Virginia</td>
<td>38.9</td>
</tr>
<tr>
<td>2</td>
<td>Florida</td>
<td>38.7</td>
</tr>
<tr>
<td>3</td>
<td>Maine</td>
<td>38.6</td>
</tr>
<tr>
<td>4</td>
<td>Pennsylvania</td>
<td>38.0</td>
</tr>
<tr>
<td>5</td>
<td>Vermont</td>
<td>37.7</td>
</tr>
<tr>
<td>6</td>
<td>Montana</td>
<td>37.5</td>
</tr>
<tr>
<td>7</td>
<td>Connecticut</td>
<td>37.4</td>
</tr>
<tr>
<td>8</td>
<td>New Hampshire</td>
<td>37.1</td>
</tr>
<tr>
<td>9</td>
<td>New Jersey</td>
<td>36.7</td>
</tr>
<tr>
<td>10</td>
<td>Rhode Island</td>
<td>36.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rank</th>
<th>State</th>
<th>Median age</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
<td>Utah</td>
<td>27.1</td>
</tr>
<tr>
<td>50</td>
<td>Texas</td>
<td>32.3</td>
</tr>
<tr>
<td>49</td>
<td>Alaska</td>
<td>32.4</td>
</tr>
<tr>
<td>48</td>
<td>Idaho</td>
<td>33.2</td>
</tr>
<tr>
<td>47</td>
<td>California</td>
<td>33.3</td>
</tr>
<tr>
<td>46</td>
<td>Georgia</td>
<td>33.4</td>
</tr>
<tr>
<td>45</td>
<td>Mississippi</td>
<td>33.8</td>
</tr>
<tr>
<td>44</td>
<td>Louisiana</td>
<td>34.0</td>
</tr>
<tr>
<td>43</td>
<td>Arizona</td>
<td>34.2</td>
</tr>
<tr>
<td>42</td>
<td>Colorado</td>
<td>34.3</td>
</tr>
</tbody>
</table>

Source: U.S. Census Bureau.

Data Projects

Where appropriate, use MINITAB, the TI-83 Plus, the TI-84 Plus, or a computer program of your choice to complete the following exercises.

1. Business and Finance  Use the data collected in data project 1 of Chapter 2 regarding earnings per share. Determine the mean, mode, median, and midrange for the two data sets. Is one measure of center more appropriate than the other for these data? Do the measures of center appear similar? What does this say about the symmetry of the distribution?

2. Sports and Leisure  Use the data collected in data project 2 of Chapter 2 regarding home runs. Determine the mean, mode, median, and midrange for the two data sets. Is one measure of center more appropriate than the other for these data? Do the measures of center appear similar? What does this say about the symmetry of the distribution?

3. Technology  Use the data collected in data project 3 of Chapter 2. Determine the mean for the frequency table created in that project. Find the actual mean length of all 50 songs. How does the grouped mean compare to the actual mean?

4. Health and Wellness  Use the data collected in data project 6 of Chapter 2 regarding heart rates. Determine the mean and standard deviation for each set of data. Do the means seem very different from one another? Do the standard deviations appear very different from one another?
5. **Politics and Economics** Use the data collected in data project 5 of Chapter 2 regarding delegates. Use the formulas for population mean and standard deviation to compute the parameters for all 50 states. What is the z score associated with California? Delaware? Ohio? Which states are more than 2 standard deviations from the mean?

6. **Your Class** Use your class as a sample. Determine the mean, median, and standard deviation for the age of students in your class. What z score would a 40-year-old have? Would it be unusual to have an age of 40? Determine the skew of the data using the Pearson coefficient of skewness. (See Exercise 48, page 141.)

## Answers to Applying the Concepts

### Section 3–1 Teacher Salaries

1. The sample mean is $22,921.67, the sample median is $16,500, and the sample mode is $11,000. If you work for the school board and do not want to raise salaries, you could say that the average teacher salary is $22,921.67.

2. If you work for the teachers’ union and want a raise for the teachers, either the sample median of $16,500 or the sample mode of $11,000 would be a good measure of center to report.

3. The outlier is $107,000. With the outlier removed, the sample mean is $15,278.18, the sample median is $16,400, and the sample mode is still $11,000. The mean is greatly affected by the outlier and allows the school board to report an average teacher salary that is not representative of a “typical” teacher salary.

4. If the salaries represented every teacher in the school district, the averages would be parameters, since we have data from the entire population.

5. The mean can be misleading in the presence of outliers, since it is greatly affected by these extreme values.

6. Since the mean is greater than both the median and the mode, the distribution is skewed to the right (positively skewed).

### Section 3–2 Blood Pressure

1. Chebyshev’s theorem does not work for scores within 1 standard deviation of the mean.

2. At least 75% (900) of the normotensive men will fall in the interval 105–141 mm Hg.

3. About 95% (1330) of the normotensive women have diastolic blood pressures between 62 and 90 mm Hg. About 95% (1235) of the hypertensive women have diastolic blood pressures between 68 and 108 mm Hg.

4. About 95% (1140) of the normotensive men have systolic blood pressures between 105 and 141 mm Hg. About 95% (1045) of the hypertensive men have systolic blood pressures between 119 and 187 mm Hg. These two ranges do overlap.

### Section 3–3 Determining Dosages

1. The quartiles could be used to describe the data results.

2. Since there are 10 mice in the upper quartile, this would mean that 4 of them survived.

3. The percentiles would give us the position of a single mouse with respect to all other mice.

4. The quartiles divide the data into four groups of equal size.

5. Standard scores would give us the position of a single mouse with respect to the mean time until the onset of sepsis.

### Section 3–4 The Noisy Workplace

From this boxplot, we see that about 25% of the readings in area 5 are above the safe hearing level of 120 decibels. Those workers in area 5 should definitely have protective ear wear. One of the readings in area 6 is above the safe hearing level. It might be a good idea to provide protective ear wear to those workers in area 6 as well. Areas 1–4 appear to be “safe” with respect to hearing level, with area 4 being the safest.